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Project Window
The Project Window is your entry point into

PatternSmith.  It lets you manage your patterns

and drag and drop copies to the cutting table

(Nesting View).  Move copies freely, or nest with-

out overlaps.  You have four easy techniques to

speed your nesting, all the way to fully automat-

ic.  After the patterns have been arranged on the

cutting table, they are ready to plot or cut. 
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Opening PatternSmith
Open PatternSmith by double-clicking the PatternSmith icon on your
desktop.  If you do not find a PatternSmith icon on your desktop,
from the Start menu, select: Programs > Autometrix > PatternSmith.

When you open a file, the Project Window is split horizontally into
the Pattern View and the Nesting View.  The Project Window has a
menu bar at the top, a status bar at the bottom, and eight dockable
toolbars.  You can position (dock) the toolbars along the top, bottom
or sides of the screen, or let them float freely on the Project Window.  

Status Bar
The Status bar is at the bottom of the Project Window screen. 

Pattern View

Nesting View
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Main Toolbar
The Main Toolbar allows you to open existing files, import existing
patterns from other files, create new files, and copy patterns from
one file to another. 
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New: Creates a new project
Open:  Opens an existing project
Save:  Saves the current project
Import:  Adds patterns from various file formats
Cut:  Removes selected patterns to clipboard
Copy:  Copies selected patterns to clipboard
Paste:  Adds copies on the clipboard to current project
Print:  Prints the active view, pattern or nesting
Selector:  Selects, moves, rotates selected patterns, copies
Undo:  Removes effects of previous operations
Redo: Reverses effects of previous Undo operations
Zoom All: Brings all patterns into view
Zoom: Zoom in with left mouse button, out with right mouse button

The status bar gives you the following information:
Name of selected pattern and number of nested copies
Perimeter and area of selected pattern(s)
Pattern rotation
Length of material used for nested patterns and nesting efficiency
Cursor position



Opening Files

To Open a File in the Project Window
1. Select the File Open tool button from the Main Toolbar.  The

Open dialog box will appear.
2. Locate Tutorial1.pat to open. Unless you changed the location

of PatternSmith during installation, it will be in the
C:\ProgramFiles\Autometrix\PatternSmith\Tutorials folder.

3. Highlight Tutorial1.pat and select Open. The patterns in
Tutorial1.pat will appear in the Pattern View of the Project
Window.

Notice that the patterns are shown in the top portion, the Pattern
View.  You will be placing copies of these patterns on the material
shown in the bottom portion of the screen, the Nesting View. 
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From the Main Toolbar, choose the File Open button.  Navigate
to the folder containing the file you want to open.  Select the file
type in the box at the bottom of the dialog box.  Double-click on
the correct file.  Select multiple files by holding the ctrl key.



Importing Files
You can bring patterns from other files into any new or open file.
When you import files, you are bringing in the patterns, not the nest-
ed copies.  PatternSmith can import Dxf, AAMA, HPGL, Gerber Cut
files, and Native formats.  You can also read and open files from ear-
lier versions of PatternSmith. 

To Import a Native file
1. Click on the Import tool. The Import dialog box appears.
2. Go to folder: C:\Program Files\Autometrix\PatternSmith\

Tutorials.
3. Select Native(*.ntv) in the ‘Files of type’ combo box. 
4. Double-click on Tutorial1.ntv.  The new patterns shown are

added in the Pattern View.  Click to place them on the screen.
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From the Main Toolbar, choose the File Import button.  Navigate
to the folder containing the file you want to open.  Select the file
type in the box at the bottom of the dialog box.  Double-click on
the correct file.  The patterns appear.  Move your mouse to where
you want the patterns placed on the Project Screen, and click to
place the patterns.  



Exporting Files
PatternSmith allows you to export in the following file formats: 
DXF file (*.dxf)

(The DXF export function exports each pattern as a 
block and an insert.)

AAMA file (*.aam)
Marker file (*.mkr)
Native file (*.ntv)

Importing/Exporting/Creating XML Files
XML (eXtensible Markup Language) is an industry-standard, flexible
way to exchange information.  XML is designed for ease of imple-
mentation and for interoperability with HTML.  It is human- and
computer- readable and can be displayed in any browser.  Because
XML is widely used in numerous industries, we’ve implemented an
XML file format for PatternSmith.  PatternSmith can import XML
(.psxml) files, and can export to an XML file.  If you want to create
XML files from another program for PatternSmith to read, contact
Autometrix for detailed information and documentation.   

Copy and Paste
The Copy and Paste buttons allow you to move patterns from one
project to another.  Experiment by creating a new project, and then
copy and paste some of the patterns to the new project. Use the
Window menu to move between projects.
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From the File drop-down menu, choose the File Export option.
Navigate to the folder containing the file you want to export.
Select the file type in the box at the bottom of the dialog box.
Double-click on the correct file.



Using the Selector in the Pattern View
The Selector tool is used in the Project Window’s Pattern and Nesting
Views to select, move and rotate either patterns or copies, as well as
to drag and drop copies from the Pattern View to the Nesting View.
Patterns or copies must be selected in order for any tools to operate
on them.
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Selecting objects
Select (highlight) a pattern or copy by clicking inside its perime-
ter with the left mouse button.  To select multiple patterns or
copies, hold the shift key while you continue selecting.
Alternatively, you can click and drag a selection box (marquee)
around a group of patterns to select all patterns enclosed by the
box.  Selected patterns show a selection point (hollow box) at
their center.

Move a Pattern or Copy 
Click and hold the left mouse button inside a selected pattern,
and the entire selection will move with the mouse.

Rotate a Pattern or Copy
To rotate a pattern or copy, click and hold the right mouse but-
ton inside any selected pattern, and move the mouse from side
to side.  Rotating a pattern does not affect copies of that pat-
tern.

Rotating Multiple Selections
When rotating multiple patterns, PatternSmith will rotate all
selected patterns about their common center.  If you want to
rotate multiple patterns around their individual centers, hold
down the Shift key before right-clicking to rotate the selections.



To Use the Selector
The pattern set on the right contains the pattern pieces for a car seat
cover.  For clarity, the patterns have been arranged as the seats
would be assembled.  The pattern set on the left contains the basic
pieces from the same seat cover, now arranged randomly.  In this
exercise you will use the Selector Tool and the Rotation Toolbar to
arrange the patterns on the left to look like the pattern set on the
right.

1. Click the left mouse button on
the Selector tool

2. Position the cursor over the
pattern L1P12. The name of the
pattern will be shown on the
Status bar and on the Pattern
Tool Tips Window that will
appear while the cursor is over
the pattern. 

3. With the cursor still over
L1P12, click and hold the left
mouse button.  Drag the pat-
tern toward the upper left-hand
corner of the Pattern View.

4. Now, click and hold the right
mouse button, while you move the mouse from side to side.
The cursor will change to indicate rotation, and the pattern will
rotate.

5. Rotate the pattern 90°, so that the two small boxes located at
the top.

Now that you have moved and rotated one of the patterns, go ahead
and move the rest of the patterns in the left pattern set to match the
patterns in the right pattern set. You can make this easier by also
using the Rotation toolbar, explained on the next page.
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Rotation Toolbar
The Rotation toolbar allows you to rotate and flip patterns. 

Rotation by Degrees
These tools let you rotate a pattern by a preset number of degrees.

Incremental Rotate
This tool allows you to rotate a pattern by the number of degrees you
specify.
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Select a pattern or group of patterns, and then click a rotation
button.  For the 0 to 180 degree buttons, the pattern will rotate
by the number of degrees specified on the button.  The pattern
will rotate in the direction indicated on the rotation button.

Zero: Rotates to alignment set in Editor
+45: Rotates pattern 45 degrees counterclockwise
-45: Rotates pattern 45 degrees clockwise
+90: Rotates patten 90 degrees counterclockwise
-90: Rotates pattern 90 degrees clockwise
180: Rotates pattern 180 degrees
Incremental Rotate: Rotates pattern specified angle
Flip Horizontal: Inverts the pattern horizontally
Flip vertical: Inverts the pattern vertically
Align by Element: Aligns pattern to make element horizontal



Invert Horizontal and Invert Vertical
These tools are available in the Pattern View and Nesting View and
can be used to flip patterns or copies horizontally or vertically.
Flipping in the Nesting View does not affect that copy’s pattern.

Once you have finished rotating and moving the patterns into place,
your screen should look like this:

You will notice that you are missing all of the mirrored patterns. To
create those patterns you will duplicate, flip, rotate, and move exist-
ing patterns. 
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Select the pattern(s) you want to rotate and click the Incremental
Rotate button.  Enter the number of degrees you want the pattern
to rotate and press Rotate.  If you do not want to view this dialog
box each time you use the tool, deselect the “Display Preset with”
command.  When you want to view the dialog box to reset the
number of degrees, right-click on the Incremental Rotate button
and check the “Display Preset with” command.

Select the pattern(s) or copy you want to flip.  Click the Invert
Horizontal or Invert Vertical button.



Group Toolbar

Duplicate
The Duplicate function makes a copy of the selected pattern(s).  You
can enter the distance you want to offset the copy from the original
pattern.

To Create a Mirrored Copy of a Pattern
1. Select pattern L1P11.
2. Click the Duplicate button on the Group

Toolbar.  The Duplicate dialog box appears.
3. Enter –15. For DeltaX and –15. for DeltaY.

Press the Duplicate button.

12 PatternSmith 

L1P11

Duplicate: Copies selected patterns
Combine: Combines selected patterns into one
Group: Groups selected patterns
UnGroup: Ungroups selected patterns

Select the pattern(s) you want to duplicate, and click the dupli-
cate button on the Group Toolbar.  Enter Delta X and DeltaY for
the distance from the pattern to its copy, and click the Duplicate
button.



4. Click the Invert Horizontal button to flip the pattern.

5. Using the left mouse button, drag the pattern to its correct
location.

6. Using the right mouse button, rotate the pattern to its correct
rotation angle.

7. Continue to duplicate, flip, and position the remainder of the
patterns using the rotation buttons, Incremental Rotate tool,
and the Invert Vertical/Horizontal tools.

Combine
Use this tool when you want to combine two or more patterns into
one pattern. You can use the Undo button to separate the patterns
again, or you can separate them in the Editor.
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Note:  When you invert a rotated pattern, you are really flipping
its image at zero degrees.  The result may not look as you expect-
ed, but is correct.

Select the patterns you want to combine and click the Combine
button.  A marquee will surround both patterns.



Group
The Group tool is used to temporarily group selected patterns or
copies together. This can be done in the Project Window or the
Nesting Window. It works well when you need to nest patterns that
will always be cut out together. When you bring copies of grouped
patterns into the Nesting View, the copies will also be grouped.

Ungroup
Use the Ungroup tool to separate grouped patterns or copies.

Moving Pattern Copies to the Nesting View
Before leaving the Project Window, try making a copy of a pattern.
(Making pattern copies will be covered in detail later.)

To Copy Patterns into the Nesting View
1. Using the left mouse button, click, hold, and drag a pattern

from the Pattern View to the Nesting View.
2. Release the mouse button.  The original pattern remains in the

Pattern View, and a copy is now in the Nesting View.
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Click and hold the pattern you want to copy.  Drag it to the
Nesting View (bottom screen) and release the mouse button.

Select the patterns or copies you want to group and click the
Group button.

Select the grouped patterns or copies you want to separate and
click the Ungroup button.



Editor Window
In the Editor Window, you can create new

patterns or edit existing ones.  Points, lines,

polylines, arcs, ellipses, and curves can be

manipulated until you have exactly the pat-

tern you want. Points can be moved, rough

curves can be smoothed, seam allowances

can be added, and text notations can be

placed inside seams.  Elements can be

rotated, joined, separated, or converted

from one type to another.

17Chapter 2|  Editor Window

2
Bringing a Pattern into the Editor

Pattern Basics
Pattern Elements,  Attributes

The Selector Tool
Moving, Rotating,Snapping

Perimeters

Main Toolbar

Attributes Toolbar

Actions Toolbar

Edit Toolbar

Alignment Toolbar

Creation Toolbar

Construction Guides

Fullness Toolbar

Triangulation Tools

Automatic Replacement Tools

Editor Menus



Bringing a Pattern into the Editor Window
Before editing a pattern, you need to bring it from the Project
Window to the Editor Window.  There you will have access to all the
tools necessary to create the exact pattern that you need.

For this section, you will need to open Tutorial2.pat located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

To Bring a Pattern into the Editor Window
1. Click the left mouse button inside the perimeter of the broken

triangle pattern.  The pattern is now selected.
2. Click the Edit Pattern button. The pattern is taken into the

Editor Window.  (Alternatively, you can double-click inside a
pattern to bring it into the Editor.)
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Status Bar
The Editor Status Bar is at the bottom of the Editor Window.

Pattern Basics

Pattern Elements
Patterns are composed of graphic elements: points, lines, polylines,
polycurves, Bezier curves, arcs, circles and text.

Element Attributes 
Each pattern element has various attributes assigned it.  These attrib-
utes, set from the Attributes Toolbar, include whether the element is
to be plot or cut and whether it is a polyline or polycurve. To view an
element’s attributes, select the element.  The toolbar will reflect the
current settings. You can use the toolbar to change a selection’s
attributes.

Pattern Perimeters
All patterns in PatternSmith must have a closed perimeter.  This pre-
vents patterns from overlapping during nesting and cutting.  There
are two types of perimeters: box and element.  A box perimeter forms
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The status bar gives you the following information:
Pattern name
Number of elements selected
Total length of all selected elements
Height and width of the entire pattern
Cursor position



a rectangle around the pattern.  An element perimeter uses the pat-
tern’s elements to form a more accurate perimeter.  

Using the Selector Tool
The Selector Tool is used extensively in the Editor Window to select,
move, rotate, and snap together points and elements.

To Select a Pattern Element
1. With the Selector tool, left-click on the Pattern Element.
2. To select more than one element, hold the shift key down while

selecting.
3. To deselect any element, the shift key acts as a toggle:  Hold it

down and click the element you want to deselect.
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Selecting elements
Select an element by clicking on it with the left mouse button.
To select multiple elements, click and drag a selection box (mar-
quee) around multiple elements to select all elements enclosed
by the box.  Alternatively, hold the shift key down while you
select elements. (Notice that while holding the shift key down,
you can select and deselect individual elements.)  Selected ele-
ments show a small box at each point or handle.  To deselect all
selected elements, click in an empty space.

Moving an element(s) 
Click and hold the left mouse button on a selected element, and
all selected elements will move with the mouse.  Be sure to click
on an element, but not on a point.

Moving a point 
Click and hold the left mouse button on a point on a selected ele-
ment, and the point will move with the mouse.



To Move a Selection
1. Select the elements you want to move. 
2. Position the cursor on any one of the elements, but not on a

point. 
3. Click the left button, hold, and drag.  

To Move a Point
1. Click on the pattern element you want to select. 
2. Position the cursor over the point you want to move. The cur-

sor will change to a cross hair. 
3. Click the left mouse button, hold, and drag.

To Rotate a Selection
1. Select the element(s) you want to rotate. 
2. Position the cursor on any of the elements, click and hold with

the right mouse button, and move the mouse from side to side.

The status bar shows the angle of rotation. To rotate in smaller incre-
ments, hold the control key down while you rotate.  This reduces the
rotation increment from 1 degree to 1/10 degree.
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Rotate an element(s)
Click and hold the right mouse button on a selected element, and
move the mouse from side to side to rotate the element.  To
rotate about a specific point, right-click on that point and move
the mouse from side to side.  To rotate in smaller increments,
hold down the Control key.

Note:  If you click on a point, the selection will rotate about that
point; if you click between points, the selection will rotate about
the center point of the element.



Snapping Points and Selections
Snapping is a very important function in computer-aided pattern-
making.  The Snap function is available while creating or editing pat-
tern elements. To see all of the available snap points, click on Options
in the Editor Menu, and then click SnapTo.
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Snapping a Point to a Point
Position the cursor over the point you want to move.  When the
cursor changes to a cross hair, click and hold the left mouse
button.  Next, press and hold the Control (Ctrl) key on your
keyboard.  Drag the point within range of its snap destination.
Release the mouse button before you release the Control key.

Snapping an Element(s) to a Point
Select the element(s) you want to move and snap.  Position the
cursor over the point you want to snap to another.  When the
cursor changes to a cross hair, press the Control key first and
then click and hold the left mouse button.  Drag the point to its
destination, and all selected elements will follow.  Release the
mouse button before you release the Control key.

Note: The only difference between snapping a point or an entire
selection is the order in which you press the Snap (ctrl) key and
the mouse button.  Press the Snap key before you click the
mouse button and you move the entire selection, snapping the
moving point.  Press the Snap key after the mouse button, and
you will only move the point.



Snap Cursors
As you move a point or selection, the cursor will change to reflect the
current mode:

To Snap an Element to Another Point
1. Left-click on the Selector Tool.
2. Left-click on the left diagonal element to select it.
3. Hold down the Control (Snap) key.
4. Position the cursor over the top left endpoint.  The cursor will

change to a cross hair.
5. Click and hold the left mouse button.
6. Move the element up to the top left point of the top line.  When

you see the cursor snap, release the mouse button.
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No snap active.

Snap active.

Snapped to startpoint

Snapped to endpoint.

Snapped to poly point.

Snapped to center, midpt.

Snapped to perpendicular.

Snapped to guide.

Snapped to intersection.

Snapped to tangent.



To Snap a Point to Another Point
1. Select the right diagonal element.
2. Position the cursor over the top right endpoint.

3. When the cursor changes to a cross hair, click and hold the left
mouse button.

4. With the mouse button still down, click and hold the Control
key to activate snap.

5. Move the cursor within snap range of the top right endpoint of
the top line, and release the mouse button.

6. In the same way, snap the bottom points together.

Constraining Movement to Horizontal or Vertical
You can use the Shift key to limit movement to either horizontal or
vertical.  While moving a point or element, hold down the Shift key to
keep your cursor position either horizontal or vertical from the start
point of the move.  This function works while editing or creating ele-
ments.

To Constrain Movement
1. Left-click on the element inside the

triangle to highlight it.
2. Position the cursor over the left point

of the element.
3. When the cursor changes to a cross

hair, press and hold down the left
mouse button.

4. Hold down the Shift key.  The cursor
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will change to horizontal or vertical arrows.
5. Move the cursor side to side and up and down to see how the

Limit function works.

Attributes Dialog
You can access the coordinate values of an element through its
Attributes Dialog.  The coordinate values can be edited directly.  

To Set the Angle and Length of a Line
1. Double-click the left mouse button on the line inside the trian-

gle. 
2. Click inside the Len (Length) edit box and type 5.0.

3. Click inside the Ang (Angle) edit box and type 45.0 degrees.
4. Press Enter.  The line is now 5 inches long at 45 degrees.
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Double-click on any element to view its Attributes Dialog.  Click
on any attribute value and enter a new number.  Press the Tab
key to see how the new value changes the element.  Although
each element type has a unique Attribute Dialog, you can edit
any of the coordinates in the same way.



Alt Selector 
The Alt Selector tool, found on the Edit toolbar, enables you to resize
a Bezier curve, polyline, polycurve, or arc while keeping the element’s
shape proportional.  As you increase or decrease the size, the shape
remains geometrically similar. (This tool only works with end-
points.)

To Use the Alt Selector
1. In the Pattern View, double-click on

the left hand Front Left shirt pat-
tern (broken perimeter).  This will
bring it into the Editor Window.

2. Starting at the top left corner and
working in a counter-clockwise
direction, snap together the end
points of the different elements
until you get to the last two end
points that need to be connect-
ed. (Remember to press down
the snap key before the left
mouse button in order for the
entire element to be snapped to
the end points.)

Notice that the end point of the
top polyline does not match up with the right end point of the
top line. This can be easily corrected using the Alt Selector tool.

3. Click the Alt Selector  tool. 
4. Position the cursor over the left endpoint of the top polyline.
5. When the cursor changes to a +, click and hold the left mouse
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Select the Alt Selector tool with the left mouse button.  Position
the cursor over one of the end-points.  Using the left mouse but-
ton, click, hold, and drag the endpoint until you have the
desired size curve.  Release the mouse button.



button.
6. As you move the mouse around,

notice how the polyline keeps it
basic shape, increasing an equal
amount in size between points.

7. With the left mouse button still
held down, press and hold the
Snap (Ctrl) Key.

8. Move the cursor near the right
endpoint of the top line. When
the points snap together, release the left mouse button and
then the Snap Key.

9.   Click “done!”

Perimeters
All patterns in PatternSmith must have a closed perimeter.  This pre-
vents patterns from overlapping during nesting and cutting.  

Perimeter Settings
Perimeter Settings are set
from the Perimeter drop
down menu, located on the
Editor Window Menu Bar.
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Use Box 
Use Box places a box perimeter around a pattern.  It is the
default perimeter setting. 

Use Elements
This uses the connected outside elements of the pattern as its
perimeter.



Viewing the Perimeter
It is often convenient to see a pattern’s current perimeter as a dashed
line.  From the Editor Window’s View menu, click on Dashed
Perimeter to place a check mark there.

When Dashed
Perimeter is checked,
an element perimeter
is displayed as a
dashed line.  A box
perimeter is only dis-
played in the Project
Window.

Start of Perimeter 
Some pattern pieces include more than one closed perimeter.  When
setting the perimeter to Use Elements, the correct perimeter may not
automatically be selected.  The Start of Perimeter option allows you
to designate the outside element(s) as the perimeter. 
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Start of Perimeter 
PatternSmith will usually find the correct elements to form a
closed path perimeter.  If not, use this option to designate a
selected element as the start of the perimeter boundary.

Note: A red stop sign on the perimeter indicates a large gap
between elements.  Snap the elements together to close the
perimeter.



To Place a Perimeter around a Pattern
1. Double-click inside the Triangle pattern to bring it into the

Editor.
2. From the Editor menu bar, choose View, and click to place a

check mark beside Dashed Perimeter.
3. From the menu bar, choose Perimeter, and select Use

Elements.  The perimeter of the triangle is now a dashed line.
4. Click Done on the Editor Menu to return to the Project

Window.

Establishing the Correct Perimeter
An element perimeter must follow two rules.  It must use a pattern’s
outermost elements and it must be closed (no gaps).

For this section, you will need to open Tutorial7.pat, located in the
folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

To Set a Perimeter to the Outermost Elements
1. Pattern 7A (top left pattern) has been designed

with a perimeter error.  Because the perimeter
is set to inside elements, you cannot double-
click to move it to the Editor Window.
Instead, drag a marquee around it and then
click the Edit Pattern Tool.

2. Select Dashed Perimeter from the View Menu.
You can see that the perimeter is set to the
small semi-circle inside the pattern.

30 PatternSmith

Select one of the elements on the outside perimeter of the pat-
tern.  From the Perimeter Menu on the Editor Menu bar, click
Start of Perimeter.  The outside elements are now shown as a
dashed line to indicate that they are the perimeter.



3. Select an element on the outside perimeter of the pattern.
4. Select Start of Perimeter from the Perimeter menu on the Edit

Menu Bar.  The dashed perimeter is now set to the outside ele-
ments of the pattern.

5. Click Done to return to the Project Window.

To Establish a Closed Perimeter
1. Double-click on Pattern 7B (top

center pattern) to bring it into the
Editor.

2. From the Perimeter menu, set the
perimeter style to “Use Elements”.
The outside perimeter changes to
a dashed line.  The red stop sign
indicates a gap in the perimeter.

3. Select the left vertical line and position the cursor over the top
endpoint.

4. Using the Snap (Ctrl) key, snap the top endpoint to the left
endpoint of the top line.  The stop sign disappears because the
perimeter is now closed.

5. Click Done to return to the Project Window.
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Main Toolbar
The Main Toolbar in the Editor Window is similar to the Main
Toolbar in the Project Window.  It allows you to save your current
pattern while in the Editor, copy and paste elements to or from other
patterns, zoom, pan, and measure.

Using the Zoom Tool
The Zoom tool can be used to view a selected portion of your pattern
in greater detail.

The Zoom Tool is used in several ways in the Editor Window.  For
basic Zoom functions, zoom in with the left mouse button and out
with the right mouse button.  Your new view will be centered about
the point you clicked with your mouse.  Alternatively, for quick
zooming, scroll up and down with the rolling wheel between your
mouse buttons to zoom in and out.  
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Save: Saves as you continue working in the Editor
Cut: Removes selected patterns to clipboard
Copy: Copies selected patterns to clipboard
Paste: Adds copies on the clipboard to current Project
Print: Prints the active view, Pattern or Nesting
Undo: Removes effects of previous operations
Redo: Reverses effects of previous undo operations
Zoom All: Brings all patterns into view
Zoom: Zoom in with left mouse button, out with right mouse button
Pan: Lets you bring any part of your pattern into view
Measure: Measures the distance between any two points



Three additional functions of the Zoom Tool use a marquee to locate
the view area.

Using the Pan Tool
The Pan tool lets you move the center of the current view.  Click and
hold the left mouse button to drag the view.  As a handy shortcut, you
can select the Pan Tool by pressing and holding the spacebar.  

Using the Measurement Tool
The Measurement Tool can be used to measure the distance between
any two points.
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Two Corner Marquees
To zoom in on a selected area of a pattern, click and hold with the
left mouse button and drag a marquis around the area you wish to
view. 

Center Marquee
You can select the center of your view if you hold down the control
key and click and hold with the left mouse button where you want
the center of your view to be.  Drag the mouse to expand the mar-
quis to enclose any portion of the pattern.  

Quick Marquee
To zoom quickly on a small area of a pattern, hold down the shift
key, click and hold with the left mouse button, and then move the
marquee to portion of the pattern you wish to view.

Left-click the Measurement Tool. Right-click the place you
wish to measure from, then right-click again where you wish to
finish your measurement.  The Measurement dialog box
appears when you are using the ruler, and will display the
measurement.  



Attributes Toolbar
The Attributes Toolbar lets you assign characteristics to each ele-
ment.

Polyline Smoothing On / Off 
The Polyline Smoothing On button creates a smooth curve through
the points of a selected polyline. The Polyline Smoothing Off button
turns off the smoothing function for a selected polyline.  A polyline is
three or more connected points.  It requires four or more points for
smoothing to take effect.
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Plot: Sets plot type to Pen
Cut: Sets plot type to Cutter1
Cut2: Sets plot type to Cutter2
Ref: Sets plot type to Reference (no output)
Open: Opens a polyline or circle
Closed: Closes a polyline or arc
Smoothing Off: Turns off polyline smoothing

Smoothing On: Turns on polyline smoothing

Group: Groups selected elements for easy selection
Ungroup: Ungroups selected elements
Set Alignment: Sets an element to be used for nesting alignment
Clear alignment: Clears an element for nesting alignment
Seams: Sets the seam allowance for an element



To Smooth Polylines
1. Double-click on the Front Left

pattern to bring it into the editor
window.

2. Select the two polylines on the
pattern.  (Press down the Shift
key while you click.)  

3. Select the Polyline Smoothing On
button. The two polylines will
change to polycurves.

Plot Type Tools
The Plot Types determine whether your elements will be plotted, cut,
or ignored on the cutting table.  Patternsmith lets you designate two
different cutting tools, Cutter #1 and Cutter #2.  Usually Cutter1 is a
rolling blade and Cutter2 a tangential blade.  Cutters are designated
in the Plot menu (Plotter Setup). 

To Set Plot Types
1. Highlight the entire perimeter of the Front Left pattern.  (Press

down the Shift Key while clicking on each of the elements.)
2. Click the left mouse button on the Set Plot Type Cut button.

The color of the elements will change to red, indicating that
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Select a polyline.  Click the Polyline Smoothing On button to
turn on the smoothing function.  Click the Polyline Smoothing
Off button to turn off the smoothing function.

Sets Plot Type to Pen
Sets Plot Type tp Cutter1
Sets Plot Type to Cutter2
Sets Plot Type to Reference (no output)



they are now cut lines.
3. Highlight the text “Front Left”.
4. Select the Set Plot Type Reference button. The color of the text

will change to yellow, indicating it is set to reference.
5. From the Perimeter Menu in the Editor Menu Bar, choose Use

Elements. The perimeter of the pattern is now a dashed line. 
6. Click Done on the Editor Menu to return to the Project

Window. 

Seam Allowances
A seam allowance may be attached to any pattern element at a specif-
ic distance from it.  The attached seam allowance moves with an ele-
ment whenever the element is moved or changed.  When a seam
allowance is added, an element’s notches automatically move out to
the cut line.  Different elements of a pattern may each have a differ-
ent seam allowance width.  

When adjacent elements have seam allowances added, they are auto-
matically connected at their intersection point.  The Seam Ends tool
from the Edit Toolbar lets you choose the style of connection you
want.

For this section, you will need to open Campshirt_Graded.pat, locat-
ed in the following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

Set Seam Allowance Widths
You can preset five different seam allowance widths.  During pattern
editing, these seam widths may be easily added to an element by
clicking the Add Seam button.
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From the Seam Menu on the Editor Menu Bar, choose Select
Seam Widths.  (Alternatively, right-click on the seam allowance
button.)  Enter the desired seam allowance widths for each of the
five presets and click Set.



To preset seam allowance widths
1. Double-click on the Front Left pattern to bring it into the

Editor Window.
2. From the Seams

drop-down menu,
select Set Seam
Widths.
(Alternatively, right-
click on the Seams
button on the
Attributes Toolbar.)
The Seam Width
Button Presets dia-
log box appears.

3. Enter the desired
values for each of
the five seam pre-
sets.  Click Set.

Add a Seam Allowance

To add a seam allowance
1. Select the top horizontal line.
2. Click the drop-down arrow next to the Seam Button to deter-

mine which of your preset seams you wish to add (Seam 1 is
the default).  Now, click the seam button directly to add a seam
allowance to the line.  Notice that the notch moves out to the
cut line.
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Select an element.  Click the seam allowance button that will give
add the desired seam width.  If neighboring element has a seam
allowance, it will automatically be connected to the new seam
allowance.  If the element is set to cut2, when you add a seam the
seam will also be cut2.



3. Add a seam allowance to the left vertical line.  Try adding a
seam allowance of a different width this time.

4. Press the Shift key and select all remaining elements.  Add a
seam allowance to all of them.

Removing a Seam Allowance
Select one or more elements. Click the seam menu, and then click
“Remove Seams”.  If a neighboring element has a seam allowance, it
will automatically change to a 90-degree return.

Seam Ends
The Seam Ends tool, located on the Edit toolbar, enables you to select
the connection style for the seam allowances of neighboring ele-
ments. 

Position the cursor at the junction of two
elements and right-click.  (Notice that you
do not need to select an element to use
this tool.)  Select your seam end option
from the Seam End Settings dialog box: 

Truncate
When you choose the Extension Seam End, Truncate clips the seam
at a multiple of the seam width.  You can enter any number between
1.0 and 2.0.
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To change the Seam End Connection style
1. Select the Seam Ends tool.
2. Click the right mouse button on the point where the top angled

line and top Bezier Curve are joined. The Seam Ends Settings
dialog box will appear 

3. Select the Slant seam end (second picture from the left at the
bottom of the dialog box) and select OK. The seam end
changes.

4. In the same way, change the seam end for the point where the
right vertical element and the top Bezier Curve meet.  Have the
Extension seam end truncate at 1 instead of 2.

Note: When you are dragging an element to a new location, you can
choose to make the seam allowances visible while you are dragging
the element.  Simply left click, begin to drag, and then press down
the right mouse button as well.  
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Actions Toolbar
The Actions Toolbar contains tools that alter or move elements.
These are passive editing functions:  make your selection, and then
click the tool to perform the function.

For this section, you will need to open Tutorial3.pat located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials.

Join Lines / Polylines 
The Join Lines / Polylines button joins multiple lines, polylines, or
polycurves into one element. You can set the distance at which two
lines will be connected.
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Join Lines/Polylines:  Joins selected lines/polylines into one polyline.
Reverse Direction:  Reverses the start and end of an element.
Incremental Move:  Moves selected elements in the X,Y direction.
Incremental Rotate:  Rotates selected elements by specified angle.
Invert Horizontal:  Flips the selection horizontally.
Invert Vertical:  Flips the selection vertically.
Add Points at Distance:  Adds points at specified location distances.
Thin Points:  Thins excess points from polylines.
Duplicate:  Creates copies of selected elements at X,Y distance.
Duplicate Offset:  Creates a perpendicular offset to selection.



To Join Polylines
1. Double-click on the left hand pattern to

move it into the Editor Window.
2. Highlight the two polylines that form the

top of the pattern.  (Press down the Shift
Key while clicking the left mouse button
on each polyline.)

3. Select the Join Lines/Polylines button. A
dialog box tells you that the two polylines
have been joined.

4. Using the Polyline Smoothing On button, convert the polyline
into a polycurve.

Incremental Rotate
This tool lets you rotate a selected element(s) by the number of
degrees you specify.
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Select the elements you want to join.  Left-click the Join Lines
/ Polylines button.  A dialog box tells you how many lines
were joined.  If all of your elements were not connected, select
Tolerances from the Options Menu in the Editor Menu Bar.
Increase your Join end-match tolerance and try again to join
the elements.

Select the element(s) you want to rotate and click the
Incremental Rotate button.  Enter the number of degrees you
want the element to rotate and press Rotate.  If you do not want
to view this dialog box each time you use the tool, deselect the
“Display Preset with” command.  When you want to view the
dialog box to reset the number of degrees, right-click on the
Incremental Rotate button.



To Rotate Incrementally
1. Use the Shift key and the left mouse but-

ton to highlight the two plot points.
2. Select the Incremental Rotate button. The

Incremental Rotate Dialog box will appear.

3.   Enter 90 in the
Degrees box and click
Rotate. The two plot
points are rotated.

Duplicate
This tool makes a copy of the current selection. A Duplicate button is
available in both the Editor Window and the Project Window. It
functions differently in each window.
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Select the element(s) you want to duplicate.  Click the Duplicate
button. The Edit Duplicate Offset dialog box will appear, giving
you three options.

Make One Copy:
Select this option to only make one copy.  Enter the X and Y off-
sets for the copy.

Fill Array:
Select this option to make multiple copies in rows and columns.
Type in the number of Rows and Columns you want and the
spacing between them.  Check the Scale Upon Completion box to
have your finished pattern scaled to a specific height and width.



To duplicate plot points
1. Use the Shift key and the left mouse button to select the two

plot points.
2.   Select the Duplicate button. The Edit Duplicate Offset dialog

box will open.
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Fill Polar Array:
Select this option to duplicate a pattern about the center of the
user origin 0,0. You can set the user origin to any location.  (If
you have opted to not automatically show the dialog box, the
Make One Copy option will be used as the default.)



3. In the Make one Copy section, enter 0.00 for Delta X and 2.00
for Delta Y.

4. Click the Duplicate button at the bottom of the dialog box.  A
duplicate pair of plot points is now located 2 inches above the
original pair.

The Scale Upon Completion function can be used in several different
ways.  One use of this function is to duplicate a valance to make an
awning pattern.  To learn to use this function, you will open a new
pattern and begin a new tutorial.  Leave Tutorial3 open; you will
come back to it and finish your work on that tutorial.

For this section, you will need to open Valance.pat located in the fol-
lowing folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials.

To duplicate and scale a valance
1. Select the valance pattern and click to enter the Editor.  

2. Using the Shift key (or ctrl + A), select the whole pattern.  
3. Left-click on the Duplicate tool.  The Edit Duplicate Offset dia-

log box opens.
4. Select the radio button for Fill Array.  You will want just one

row (one cell in the vertical direction) and 8 columns (eight
duplicate cells created and placed horizontally).  
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5. Check the box for Scale Upon Completion.  Since your column
spacing is 10.00, with eight valances your finished series of
duplicate valances would be 80.00 inches.  However, you are
going to scale the final size.  In the New Width box, enter
88.00.  Click Duplicate.

6. Your duplicate valances are created.  The status bar at the bot-
tom of the screen shows you that the columns have been
scaled, and the total width of your valances together is 88.00
inches.
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Incremental Move 
This tool lets you move an element(s) or a point by whatever distance
that you specify.

For this section, you will need to return to Tutorial3.pat and continue
the tutorial.

To move a point incrementally
1. Select the line on the left side of the pattern.
2. Position the cursor over the point you want

to move. Notice the cursor change to a
cross-hair. Click the left mouse button.

3. Click the Incremental Move button. The
Incremental Move dialog box will appear.

4. Enter -1.00 for Delta X and 0.00 for Delta Y
5. Press Move. Notice that only the lower

point of the element moves to the left.
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Moving an element(s):
Select the element(s) and then click the Incremental Move but-
ton.  The Incremental Move dialog box will appear.  In the Delta
X and Delta Y boxes, enter the distance you want the element(s)
to move.  Press Move.

Moving a point:
Select the element that contains the point you want to move.
Left-click on the point.  Click the Incremental Move button.  In
the Delta X and Delta Y boxes, enter the distance you want the
point to move.  Press Move.  Notice that the entire element does
not move, only the selected point.  This changes the shape of the
element.



6. In the same way, make the right side of the pattern mirror the
left side.  This time, you will enter +1.00 for DeltaX.

7. Using the Snap function (Control Key), attach the end points of
the bottom line to the side lines.

Reverse Direction
The Reverse button lets you exchange the start and end points of an
element.  The start point is shown with a hollow square handle, and
the end point has a solid handle.  If your perimeter is set to use ele-
ments, instead of a box perimeter, all elements will go counterclock-
wise.  Interior elements can go any direction you want, however you
want them plotted.

Add Points at Distance
This tool lets you add points to a line, polyline, or polycurve.

47Chapter 2|  Editor Window

Distance
Enter the distance in units.

Percent
Enter the distance as a percentage of the element’s length.

From Start / From End
Check to place the new point(s) relative to either the start or end,
or from both.

Add Multiple Points
Check to have multiple points added at the increment you specify.

Select an element. Click the Add Points at Distance button.  The
add Points at Distance dialog box appears.  Enter the distance
between the first (or last) point and the point you are adding.
You have four options:



To add points to a line
1. Select the left-hand 45° line.
2. Select the Add Points at Distance tool.

The Add Point at Distance dialog appears.
3. Enter 50 in the Percent box and press OK.

A point is added at the line’s midpoint.

4. In the same
way, add a mid-
point to the right-
hand 45° line.

5. Using the Snap function, connect the end-
points of the interior horizontal line to the
midpoints you just created.

Duplicate with Offset 
The Duplicate Offset tool allows you to create a copy of an element,
offset by a specified distance in a direction perpindicular at every
point to the original element.  You can offset multiple elements at a
time.  With a Bezier curve, the offset copy will be converted to a poly-
curve. You can reset the element to a Bezier curve after the offset has
been created.  This tool works well if you want to create a duplicate
pattern that is larger by a specified distance.  
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Select the element.  Click the Duplicate Offset tool.  The Duplicate
Offset dialog box will appear.  Enter the distance you want the
duplicate offset from the original.



To construct a perpendicular offset
1. Select the left and right vertical lines.
2. Click the Offset Element tool. The Offset Element dialog box

will appear.

3. Enter -0.75 in the box and press OK.
4. Remember that the final preparation

for nesting is setting the plot type
and establishing the perimeter.

Thin Points
The Thin Points tool is a handy way to remove excess points from a
polyline while making it smoother in the process.  Select the poly-
curve you want to thin, and click the Thin button.  The function will
remove points until remov-
ing more would change the
curve by more than the
Maximum Error you
entered.  If you check the
Construction Algorithm,
the function first adds extra
points to the curve, and can
then do a much better job
of smoothing.
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Edit Toolbar
The Edit Toolbar enables you to change or edit a selected element.
For example, you can change an element’s length, add or remove
points, or break an element into two elements.  Click the desired tool
with the left mouse button, and then perform the editing action with
the right mouse button.  The left mouse button remains a Selector.

For this section, you will need to open Tutorial4.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials
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Selector:  Selects, moves and rotates elements
Seam End Selector:  Lets you change seam end styles
Alt Selector:  Lets you proportionally resize any element
Break at Point/ Break at Intersection:  
Add/ Delete Point:  Adds or removes points from polylines
Arc Fit:  Converts lines or polylines to arcs
Bezier Fit:  Converts arcs, lines, or polylines into Bezier curves
Set Length:  Changes the length of any element
Extend/ Trim:  Extends or trims an element to an intersection point
Align Horizontal:  Aligns selected elements horizontally or to another
Mirror:  Mirrors selected elements about a centerline element
Make Symmetric:  Averages two selected elements about centerline
Arc Fillet:  Inserts an arc between elements
Bezier Fillet:  Inserts a Bezier curve between elements



Break at Point / Break at Intersection
This tool enables you to break an element into two elements at a
given point or at its intersection with another element. 

Before smoothing a polyline, it is important to break it at corners and
wherever you want to maintain a sharp angle.  If you are unsure
where to break your polyline, with your right mouse button drag a
marquee around several possible points. PatternSmith will break the
polyline at the point that has the largest angle change.

When breaking a polyline with smoothing applied, PatternSmith will
add as many additional points as necessary to maintain the shape of
your smooth curves.  If you do not want points added and smoothing
maintained, hold down the ctrl key while clicking a point to break an
element, or drag a marquee around the point.  
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Break at Point
With the left mouse button, select the polyline you want to
divide into two elements. With the right mouse button, click on
the point where you want to break the polyline.  Alternatively,
using the right mouse button, draw a marquee around the point
where you want to break the polyline.  The polyline is now bro-
ken into two elements.

Break at Intersection
With the left mouse button, select the element(s)you want to
break.  With the right button, click on an element that intersects
it.  The selected element(s) will break at the intersection. 



To Break at a Point
1. Double-click on the left-hand pattern

to bring it into the Editor Window.
2. Select the Break at Point / Break with

Element tool using the left mouse but-
ton.

3. Position the cursor over the bottom left corner point.
4. Click the right mouse button.  The element is now bro-

ken at the corner point.
5. In the same way, break the top right corner.

To Break using a Marquee
1. Select the Break at Point / Break with Element tool.
2. Position the cursor above and to the left of the

bottom right point.
3. Using the right mouse button, click, hold, and

drag down and to the right to draw a dashed
marquee around the point.

4. Release the right mouse button.  The element is
now broken.

5. In the same way, break the top right corner using
a marquee. Your corners are all broken now.

6. Using the Polyline Smoothing On button, smooth the top and
bottom polylines of the pattern.

To Break at the Intersection with Another Element
1. Select the Break at Point / Break with Element tool with the

left mouse button.
2. Select the circle inside the pattern.
3. Position the cursor on one of the lines intersecting the circle

and click the right mouse button. The circle will be broken
into two arcs at the points where the line intersects the cir-
cle.

4. In the same way, break the arc where the other line intersects
the circle. You now have four arcs.

5. Highlight the two lines using the left mouse button and the
Shift Key.
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6. Position the cursor over the left arc and click the right mouse
button. The line on the left is now broken into three elements.

7. Position the cursor over the right arc and click the right
mouse button. The line on the right is now broken into
three elements.

8. Select the four lines outside the circle and the two small
arcs between the lines.

9. Press the Delete button on the keyboard. The lines and
arcs will be cleared, leaving two cutout shapes.

Add / Remove Points
This tool lets you add points to a polyline or remove existing points.

To add / remove points
1. Click the Add / Remove Points tool.  Notice that the cursor

changes.
2. Select the bottom curve and position the cursor over one of the

points. The cursor will change to show a minus sign.
3. Click the right mouse button.  The point is now removed.
4. Now positon the cursor over a place on the bottom curve where

there is not a point. The cursor will change to show a plus sign.
5. Click the right mouse button. A point is added at the cursor

location.
6. Now, select the bottom right horizontal polyline.  Using the

Add / Remove Points tool, right-click on the middle point to
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Select the Add / Remove Points tool.  Select the polyline(s) or
polycurve(s) you want to edit. Position the cursor over the poly-
line and the cursor will change to show a plus sign. Click with
the right button to add a point at the cursor location. Position
the cursor over an existing point and the cursor will show a
minus sign.  Right button click to delete the point. You can
delete multiple points at once by drawing a marquis around
them with the right button.



remove it.
7. Using the right mouse button, drag a mar-

quee around the remaining two points to
delete them.

Bezier Fit
The Bezier tool is a very effective smoothing tool that can save you a
lot of time in pattern creation, editing, and cutting.  Any polyline or
polycurve may be replaced with a Bezier curve.  The Bezier curve will
follow the original curve as closely as possible.  As you manipulate
the Bezier curve, the original curve will remain visible in the back-
ground.

To more accurately shape your Bezier curve, use the Add / Remove
Points tool to add more Bezier points on the curve.  A Bezier curve
may be converted back to a polyline(s) or polycurve(s).

To Fit a Bezier Curve
1. Click the Bezier Fit tool.
2. Select the lower polycurve. 
3. Position the cursor on the line.  Notice that the cursor changes.

Click the right mouse button and the polycurve changes to a
Bezier curve.

4. Position your cursor over the endpoint of one of the handles. 
5. Using the left mouse button, click, hold, and drag the handle to

manipulate the Bezier curve.  Notice that the original curve
remains visible in the background.
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Using the Bezier Fit tool, select the polycurve you want to
replace.  Click the right mouse button to convert the polycurve to
a Bezier curve.  Using the left mouse button, drag the endpoint
of the Bezier handles to manipulate the curve.  A Bezier curve is
always tangent to the handles at the endpoints.



6. Manipulate both handles to achieve the best fit.  If you want to
view the handles while you are manipulating the curve, click
with the left mouse button and begin to move the handles, then
press down the right mouse button additionally.  The handles
will now be visible while you are manipulating the Bezier curve.

Arc Fit
The Arc Fit tool is another effective smoothing tool.  An arc may
replace any polyline or polycurve.  The arc will follow the original
curve as closely as possible.  As you manipulate the arc, the original
curve will remain visible in the background.

To Fit an Arc
1. Click the Arc Fit  tool.
2. Select the upper polycurve.
3. Position the cursor on the curve. The cursor changes.
4. Click the right mouse button. The polycurve changes to an arc. 
5. Notice that the fit is not very good.  Change the upper poly-

curve to a Bezier curve to see if you can achieve a closer fit.
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Click the Arc Fit tool with the left mouse button.  Select the poly-
curve you want to replace.  Position the cursor over the poly-
curve.  Notice that the cursor changes.  Click the right mouse
button to convert the polycurve to an arc.  Using the left mouse
button, drag the center point to manipulate the arc. 



6. Using the Arc Fit tool, replace the right-hand vertical polycurve
with an arc.  Notice how closely the arc fits the curve.  Using
the center point, manipulate the arc to achieve the best possi-
ble fit.

7. To remove the original curves (gray lines) from the screen,
select View from the Editor Menu.  Click Clear Originals Layer.
The gray lines disappear.

8. Using the Move / Rotate tool, snap the left endpoint of the bot-
tom horizontal line to the right endpoint of the lower Bezier
curve.

Extend / Trim to Intersection
This tool allows you to extend or trim an element to its point of inter-
section with another element.

To Extend or Trim to an Intersection
1. Click the Extend / Trim to Intersection tool.
2. Select the left-hand interior line.
3. Position the cursor over the lower

Bezier curve. The cursor changes. 
4. Click the right mouse button. The

interior line now extends to inter-
sect the lower Bezier curve.

5. Extend the same interior line to
intersect the upper Bezier curve.

6. In the same way, extend and trim the right interior line to
intersect the upper and lower Bezier curves.
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Click the Extend / Trim to Intersection tool with the left mouse
button.  Select (highlight) the element you want to extend or
shorten.  With the right button, click on the element that you
want to intersect.  The highlighted element will lengthen or
shorten until it intersects the second element.



Set Length
The Set Length tool allows you to assign a length to a selected ele-
ment.  Neighboring elements can be automatically rotated so their
endpoints stay connected with the selected element without changing
their own lengths.

To Set a Length
1. Click the Set Length tool.
2. Select the upper Bezier Curve, right side arc, and bottom hori-

zontal line.
3. Position the cursor over the arc and right-click. The Set Length

dialog box appears.  
4. Enter 13.00 in the New Length box

and press OK.  Notice how the ele-
ments change size.

5. The interior lines are no longer con-
nected to the upper Bezier curve.
Using the Extend / Trim to
Intersection tool, extend the interior
lines so they intersect with the upper Bezier curve.

6. Select the perimeter elements and the interior cutouts.  (While
holding down the Shift key, select all perimeter elements and
draw a marquee around the interior cutouts.)  Click the Set Plot
Type Cut1 button.  The elements are now red to show that they
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Click the Set Length tool with the left mouse button.  Select up to
three connected elements.  Right-click on the element whose
length is being changed.  The Set Length dialog box appears.
Enter the desired length.  Press OK.  If only one element was
selected, its length is now changed to the new value.  If two ele-
ments were selected, the neighbor element will rotate about its
other endpoint to accommodate the changed element.  If three
elements were selected, both neighboring elements will rotate to
accommodate the changed element.



are cut elements.
7. From the Perimeter Menu on the Editor Menu bar, click Use

Elements.  Notice that a dashed perimeter is now around one
of the interior cutouts.  For nesting purposes, you want the out-
side elements to be the perimeter.

8. Select one of the elements on the pattern’s outside perimeter.
9. From the Perimeter Menu on the Editor Menu bar, click Start

of Perimeter.  Notice that the outside elements are now shown
as the perimeter.

Mirror
The Mirror tool allows you to create copies of selected elements, mir-
roring them about a selected centerline.  

Align Horizontal
The Alignment tool lets you rotate an element to horizontal.  All
other selected elements will rotate to maintain their original relative
positions.  You can also align selected elements to a reference ele-
ment positioned at any angle.
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Select all of the elements you want to mirror, including the cen-
terline or mirror line.  Right click on the mirror line to mirror
the selected elements.  The mirror line will change to a reference
element.

To Rotate to Horizontal
Select all of the elements you want to realign.  Right click on the
element that you want to make horizontal.  All selected elements
rotate to maintain their original relationship.



Alignment is often used when joining two portions of a pattern that
have been digitized separately, as shown below.  First, align the two
halves of the pattern so that the joining lines are parallel, then snap
the two halves together.  

Make Symmetric
The Make Symmetric Tool allows you to make selected elements
symmetrical by averaging pairs of elements about a chosen line of
symmetry.
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To Align to an Element
Select all of the elements you want to realign.  Hold down the
Shift key, and right click the element you want to align.
Continue holding the shift key and right click the element whose
alignment you want to match.  The entire selection will rotate so
that the alignment element (first click) will be parallel to the ref-
erence element (second click).  

Align Snap

Select one pair of elements that you want to make symmetrical.
Next, right click on the line of symmetry.  The resulting elements
will be the average of the originals.  You will see extra points
added to the resulting elements, and no smoothing has been
done.  Use a Bezier or Arc fit, or some other technique to smooth
the resulting elements.



For this example, you will need to open Tutorial11.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith 2005\Tutorials

To Average (make symmetrical) Two Elements
1. Double-click to bring the pattern on the

far left into the Editor. 
2. Click the Make Symmetrical tool.
3. Select the left and right vertical edges. 
4. Right click the vertical centerline.

The elements have been averaged, with extra
points added.  Convert the resulting curves to
Bezier curves.  The top and bottom elements no
longer meet, so move their endpoints, snapping
them to their neighbors.  Finally, convert the top
element to an arc.

Arc Fillet
The Arc Fillet tool joins elements with an arc that is tangent to both
elements.  The elements do not have to meet at a point, and you can
also replace an existing polyline with an arc fillet.
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Add a Fillet Between Two Elements
Select two elements.  They can be either connected elements that
meet at a corner, or two disconnected elements.  With the Arc
Fillet tool, right click on either element, near the end where the
fillet will be added.  In the dialog, enter the radius, and click
Fillet.



For this section, you will need to open Tutorial12.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

To Create a Fillet between Connected Elements
1. Double-click on the top pattern (example 1) to bring it into the

Editor Window.
2. Click the Arc Fillet tool. 
3. Select the two connected elements on the far left.  Move

the cursor over either of the selected elements, near
their intersection, until the Arc Fillet cursor appears.

4. Right-click, and the Arc Fillet dialog box will appear.

5. Enter 6.0 inches for the arc radius, and click Fillet.  The corner
changes to an arc fillet with a radius of 6 inches.  

Try creating fillets for the other corners in this example.  Notice that for
some of the corners, a warning box appears saying that PatternSmith was
unable to place the fillet with the specified radius.  That is because the
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Replace a Polyline with a Fillet
Select two elements and the connecting polyline that you want to
convert to an arc fillet.  Right click on the polyline.  The program
will measure the radius of the existing polyline, and fill in the
measured radius in the dialog box.  You can leave that or change
the value for radius, and then click Fillet.  



radius of 6 inches is too large.  Try again with a smaller radius.

To Create a Fillet between Disconnected Elements
Bring the example 2 pattern into the editor, and repeat the steps shown
above.   Elements do not need to be connected in order to add an arc fillet.

To Convert a Polyline to a Fillet
1. Bring the example 3 pattern into the editor, and select the sec-

ond figure from the left.
2. Select the Arc Fillet tool.
3. Right click on the polyline corner.
4. The Arc Fillet dialog will appear, with a radius very close to 6.0

inches preset.  That is the measured radius of the polyline.

5. You can leave the
measured value, or you
can manually enter a
value (such as 6.00)
and click Fillet.  The
corner will change
from a polyline to an
arc fillet.

Bezier Fillet 
The Bezier Fillet tool joins elements with a Bezier curve that is tan-
gent to both elements.  If the elements are joined by a polycurve, the
program will fit the best possible Bezier curve to the existing poly-
curve.
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polyline
arc



For this example, continue using Tutorial12.pat, located in:
C:\Program Files\Autometrix\PatternSmith\Tutorials

To Convert a Polyline to a Bezier Fillet
1. Double-click the example 4 pattern to bring it

into the Editor Window.
2. Click on the Bezier Fillet tool. 
3. Select the entire figure on the left.  Move the

cursor over the polyline element until the Bezier
Fillet cursor appears.  Right-click, and the poly-
line is changed to a Bezier curve.

4. Do the same with the figure on the right.
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Select two elements and the polycurve that joins them.  Left-
click on the Bezier Fillet tool.  Right-click on the polycurve.
The polycurve is changed to the best fit Bezier curve, tangent
at the endpoints.

polyline

bezier



Alignment Toolbar
Tools on the Alignment Toolbar allow you to align elements by their
minimums and maximums or by their centers.  You can also set lines
parallel to one another, create lines of symmetry, and distribute ele-
ments evenly using the Alignment Toolbar.  

For this section, you will need to open Tutorial11.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

Make Parallel 
The Make Parallel tool allows you to make selected elements parallel
to a specific element. 

64 PatternSmith 

Make Parallel:  Makes selected elements parallel to one another.
Line of Symmetry:  Locates a line of symmetry for selected elements.
Align Left:  Aligns selected elements with left side of chosen element.
Align Right:  Aligns selected elements with right side of chosen elem.
Align Tops:  Aligns selected elements with top of a chosen element.
Align Bottoms:  Aligns selected elements with bottom of chosen elem.
Distribute Evenly:  Distributes selected elements at specific distance.

Select two elements you want to make parallel.  Select the Make
Parallel tool.  Right-click on the element you want the other line
to be parallel to.  A dialog box will appear, allowing you to choose
the desired distance between the two elements.  The element you
clicked on will remain stationary, and the second element will be
made parallel to the first.  You can also make multiple elements
parallel. 



To make selected lines parallel
1. In the Project Window, select the pattern on the left consisting

of four lines.  Double-click on the pattern to bring it into the
Editor Window.

2. Using the left mouse button, drag a marquis around the four
lines to select them all.  

3. Select the Make Parallel button on the Alignment Toolbar.
4. Choose which of the four elements you want the remaining ele-

ments to be parallel to, and right-click on that element. The
elements are now parallel to the chosen element.

5. Click “Done!”

Line of Symmetry
The Line of Symmetry tool allows you to find the best possible line of
symmetry for a pattern.

To create a line of symmetry and make a pattern symmetrical
1. In the Project Window, select the pattern in the top right cor-

ner.  Double-click on the pattern to bring it into the Editor
Window.

2. Select the diagonal elements on the right and left sides.  Left-
click on the Line of Symmetry tool.

3. Notice that this is not the best possible line of symmetry.  Click
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Select two or more elements for which you wish to find a line of
symmetry.  Left-click the Line of Symmetry tool.  Vertical and
horizontal guidelines will appear.  You can try finding several dif-
ferent lines of symmetry for one pattern by selecting different ele-
ments of the pattern each time.  You can erase unwanted lines of
symmetry by clicking the erase guides tool.  You can snap poly-
lines to the guideline you wish to use.  You can then use the Make
Symmetric tool to make selected elements symmetric about this
guideline. 



the Erase Guides tool.  
4. Select all of the horizontal elements and create a new line of

symmetry.  This line works nicely.
5. Snap a line to the vertical line of symmetry.  Erase the guide-

lines.
6. Select similar vertical and diagonal elements in pairs.  One pair

at a time, left-click the Make Symmetric tool and then right-
click the vertical line you created to make each pair symmetri-
cal.  The elements will shift slightly to be symmetrical.  You will
still see the original lines in gray.

7. Snap the horizonal lines to the pairs of newly symmetrical
lines.

8. Click “Done!”

Align Elements
The Align Elements tools allow you to align selected elements with
one another. 

To align elements
1. In the Project Window, select the third pattern from the right,

consisting of four rectangles.  Double-click on the pattern to
bring it into the Editor Window.

2. Using the left mouse button, drag a marquis around the four
elements to select them all.  

3. Left-click on the Align Left button on the Alignment Toolbar.
4. Choose which of the four elements you want the remaining ele-

ments to be aligned with, and right-click on any portion of that
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Select two or more elements you want to align.  Select the Align
Left, Align Right, Align Top, or Align Bottom tool.  Right-click on
the element you want the other element(s) to be parallel to.  The
other elements(s) are now aligned with the element you chose
and clicked on, according to which Align tool you chose.
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element.  A dialogue box appears, allowing you to choose to
align the elements by either element borders or element cen-
ters. Select your preference and click “OK”.  The elements are
now aligned.

5. In the same way, practice aligning the elements to the right,
top, and bottom.

Distribute Evenly
The Distribute Evenly tool allows you to distribute selected elements
evenly. 

To distribute evenly
1. In the Editor Window, select all four rectangles.  
2. Left-click on the Distribute Evenly button on the Alignment

Toolbar.
3. For the X Spacing, enter 4.00 in.  For the Y Spacing, enter 3.00

in.
4. Select “Align by element minimum X and Y values” and click

OK.
5. The elements are now evenly distributed and aligned according

to the settings you selected.
6. Try distributing the elements again in various ways, such as by

aligning them by their centers.
7. Click “Done!”

Select two or more elements you want to distribute evenly.  Select
the Distribute Evenly tool.  Enter the desired number of inches in
X spacing and in Y spacing.  Choose to have the elements aligned
by the element minimum X and Y values or by the element cen-
ters.  Select OK.



Creation Toolbar
Tools on the Creation Toolbar let you create new elements.  All ele-
ments can be created freehand with the mouse, or by entering data
coordinates from the keyboard.  Various construction guides give you
helpful temporary snap locations.

Units of Measure
Before you create an element, choose the appropriate unit of meas-
ure.  You may use inches, feet, yards, millimeters, or meters.  You can
change units at any time during pattern construction.
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Create Point: Create a point in a specified position.
Create Line: Create a line of any length.
Create Polyline: Create a series of joined segments.
Create Arc: Create arcs of a circle.
Create Circle: Create a circle with a chosen radius.
Create Elipse: Create an elipse of any size.
Create Rectangle: Create a rectangle of any size.
Create Polygon:  Create a polygon of any size.
Create Bezier: Create a Bezier Curve.
Create Notch: Attach notches to an element.
Create Anchor Point: Attach equally spaced anchors to an element.
Create Text: Create text on a pattern.
Create Font: Choose a font for your text.

Click Units in the Options Menu of the Editor Menu Bar.  Click
on the desired unit of measurement.  A check is placed in front of
the chosen unit to let you know that it is active.



Mouse Coordinate Entry
Points, lines, polylines, arcs, circles, ellipses, and rectangles can all be
created by entering data points with your mouse.  

Keyboard Coordinate Entry

You may also enter coordinate data through the Keyboard Creation
Toolbar.  The Keyboard Creation Toolbar appears only when you
have a tool selected.  When no tool is selected, this dialogue box dis-
plays the current coordinates of your mouse.
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Left-click the desired tool button.  Then use the right mouse but-
ton to create new elements.  Remember that the Snap (Ctrl) and
Constrain (Shift) keys are available at all times while creating
new elements.

Press the tab key to toggle control from the mouse to the coordi-
nate box on the Keyboard Creation Toolbar.  The toolbar prompts
you for the next data point information. Separate all coordinates
with a space or a comma.  Press Return after entering each coor-
dinate pair.



You can enter keyboard coordinates in three different ways:

Absolute Coordinates
You may enter coordinates as absolute locations. 
Coordinates are measured from the current origin in the units
you have chosen in the Options Menu of the Editor Menu bar.
PatternSmith defaults to absolute coordinates.  If you have
been using relative coordinates, change back to absolute coor-
dinates by typing the letter ‘a’ while entering a coordinate
pair.

Relative (Delta) Coordinates
You can enter data in relative mode (delta x and delta y) by
pressing the letter ‘d’ at any time while entering a coordinate
pair.  Coordinates indicate the x and y distance from the last
point entered.

Relative Polar Coordinates
You may enter points in relative polar coordinates by pressing
the letter ‘r’ at any time while entering a coordinate pair.
Coordinates indicate the length and angle from the last point
entered. Zero degrees is the positive x direction, and positive
angles are counter-clockwise.  

Create Point Tool
The Create Point tool allows you to create points in specified loca-
tions.  You may choose to make them plot points, cut points, or refer-
ence points.  Plot points will be plotted as small “plus signs”, cut
points will be treated like drill holes in the cutting process, and refer-
ence points will not be plotted or cut.  It is possible to add up to two
reference or cut letters to indicate the purpose of a point.
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Left-click the Create Point tool.  Right-click to enter points in the
desired locations.  Or, use the Keyboard Creation Toolbar to enter
coordinate for your points.



For this section, you will need to open Tutorial5.pat, located in the
folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

This file contains a pool cover pattern.  You will create that same pat-
tern using tools from the Creation Toolbar.  On the opposite page,
you will see a dimensioned drawing of the pool cover.

POOL COVER DIMENSIONS

Before we begin creating the pool cover pattern, remember to
set your units of measurement to feet.
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Create Line Tool
This tool lets you create a line of any length.

To create a line of a given length (using the Keyboard Creation
Toolbar)

1. Click the Create Line tool.
2. Press the Tab Key to activate the data entry box in the

Keyboard Creation Toolbar. 
3. For the first point, type 0,0 and press Enter.
4. For the second point type in 32,0 and press Enter. You now

have a 32-foot horizontal baseline.
5. Click the Zoom All button to view the entire line.

To create a line of a given length (using the Relative or Delta
Mode)

1. Select the Create Line tool.
2. Click and hold the Snap (Control) key as you position the cur-

sor near the right endpoint of the baseline. The cursor changes
to a crosshair.

3. Click the right mouse button. The first point of your new line
snaps to the right endpoint of the original line.  Release the
mouse button.

4. Now press the Tab key. The Keyboard Creation Toolbar edit
box is highlighted.

5. Type “d” to prepare to enter relative delta coordinates.  Type in
the coordinates 0,4 and press Enter.  A four-foot vertical line
appears on the screen.
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Left-click the Create Line tool.  Right-click to enter the first point.
Drag your mouse in any direction.  Right-click again to establish
an endpoint for the line.  You can use Snap and Constrain keys to
assist you in creating your line.



Create Arc Tool
This tool enables you to create arcs of circles.

Arcs can be created using three different styles.  Right-click on the
tool button to set the style you want to use.

Start Point, End Point, Point on Arc
Enter the start point, end point, and any point on the arc.

Start Point, End Point, Height
Enter the start point, end point, and height (or offset) from
the chord line to the deepest point on the arc.

Center, Start Point, Sweep
Enter the Center of the arc, the start point, and the sweep
angle (the arc’s included angle).

Snap and Constrain keys can be used, and you can toggle to the coor-
dinate box on the Keyboard Creation Toolbar to enter precise coordi-
nates.

To create an arc based on Start Point, End Point, and Height
1. Click the right mouse button on the Create Arc tool. The Arc

Construction Preferences dialog box appears.
2. Select the Start Point, End Point, Height radio button and

select OK.
3. Press and hold the Control (Snap) key, and position the cursor
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over the top point of the four-foot line.
4. When the cursor changes shape, click the right mouse button to

position the first point of the arc. Release the Snap key.
5. Press the Tab key to activate the Keyboard creation toolbar.

Press ‘d’ for relative delta mode.
6. To set the End Point, type the coordinates 0,12 and press

Enter.
7. For the height, type –4.0 and press Enter.
8. Click the Zoom All tool to view the entire shape.

Create Polyline Tool
This tool lets you create a polyline: a series of connected line seg-
ments.

To create a polyline
1. Select the Create Polyline tool.
2. Select the arc.  Press and hold the Control (Snap) key, and

position the cursor over the top point of the arc.  
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Left-click on the Create Polyline tool.  Right-click to enter the
first point.  In the same way, enter the other points in your poly-
line.  To enter the endpoint, double-click. If you are entering
coordinates at the keyboard in absolute mode, press Enter twice
to end the polyline. In delta mode, after entering your endpoint,
type 0,0 and press Enter.  You can use the Snap and Constrain
keys to assist you in creating your polyline.



3. When the cursor changes shape, right-click to start the polyline
at your snap point.

4. Press the Tab key to activate the Keyboard creation toolbar.
5. Press ‘d’ for relative delta mode.  Type in the coordinates 0,4

and press Enter to create the first leg of the polyline. 
6. The Keyboard entry box remains in Relative Delta mode, ready

for the next set of coordinates.  Type in the next two sets of
coordinates: 
-7,0 (Enter), 0,2 (Enter).

7. To indicate that you have entered your endpoint, type 0,0 and
press Enter. 

In the same way, we will create a polyline for the left side of the pool
cover:

1. Snap the first point to the left endpoint of the baseline.
2. At the keyboard, enter the following distances in Relative

(delta) mode:
0,4 (Enter) -1.5,0 (Enter) 0,3 (Enter) -1.5,0 (Enter)
0,6 (Enter) 1.5,0 (Enter) 0,3 (Enter) 1.5,0 (Enter)

0,4 (Enter) 7,0 (Enter) 0,2 (Enter) 0,0 (Enter)

You can use Relative Polar mode to create the angled lines at the top
of the pool.

To create lines in Relative Polar mode
1. Select the Create Line tool.
2. Using the Snap (Control) key, position the cursor near the last

point on the polyline to the right. The cursor changes to a
crosshair.

3. Click the right mouse button. The first point of your new line
snaps to the endpoint of the polyline on the right.

4. Press the Tab key to highlight the Keyboard Creation Toolbar
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edit box.
5. Type ‘r’ for the Relative Polar mode.  Enter 5, 150 (length of

line, angle measurement) and press Enter.
6. In the same way, create an angled line snapped to the left side

end point. Use 5 for the length and 30° for the angle measure-
ment.

To complete the perimeter of the pool cover:
1. Select the Create Lines tool.
2. Using the Snap (Control) key, snap the first point of your new

line to the endpoint of either angled line.
3. Still using the Snap key, snap the endpoint of the new line to

the endpoint of the remaining angled line.

Set Origin Tool
While editing patterns, you can relocate the User Origin (default:

x=0,y=0) to any point in the pattern.

To set the Origin
1. Click the left mouse button over the Set Origin tool.  Move the

cursor to the middle of the baseline (bottom horizontal line).  
2. Press and hold the Control (Snap) key to activate snapping.
3. When the cursor changes shape, click the left mouse button

and then release the Control key. The Origin is now set to the
midpoint of the baseline.

Create Circle Tool
This tool enables you to create circles by entering the center point
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On the Guides toolbar, left-click the Set Origin tool.  Move the
cursor to a new location where you wish to set your new origin.
Left-click to set the origin.  Use the Snap key to snap the origin to
any point. You can relocate the origin at any time during an edit-
ing session.



and radius of the circle.

To create a circle
1. Select the Create Circles tool.
2. Press the Tab key to activate the Keyboard Creation Toolbar.
3. For the Center Point, type in the coordinates 1.0,1.0 and press

Enter.
4. For the radius, type in .2 and press Enter. A circle appears on

the screen.
5. Create another circle, with the coordinate -1.0,1.0 and a radius

of .25.

To add the holes at the top of the pattern
1. Left-click the Set Origin tool.
2. While holding down the Snap key, drag the origin near the

midpoint of the top horizontal line. When the cursor changes
shape, release the left mouse button and then the Snap key.
The Origin is now set.

3. Select the Create Circles tool.
4. Press the Tab key to activate the Keyboard Creation Toolbar.
5. For the Center Point type in the coordinates -1.0, 1.0 and press

Enter.
6. For the radius type in .2 and press Enter. 

To use the Duplicate Tool to create another circle
1. Highlight the circle you just created.
2. Select the Duplicate tool.
3. In the Edit Duplicate Offset dialog box, type in 2.0 for Delta X

77Chapter 2|  Editor Window

Select the Create Circle Tool.  Using the right mouse button, click
to set the center of the circle. Move the mouse to draw the desired
circle.  Right-click to set the radius.  You may use the Snap and
Constrain keys to assist you in circle design and location.
Alternatively, you can press tab to activate the coordinate box and
then enter precise center coordinates and a radius measurement.



and 0.0 for Delta Y.  Click the Duplicate button.  The circle is
duplicated 2 feet to the right.

4. Now add the holes on the left side of the pool cover, setting

your origin to the closest corners. Refer to the drawing on page
69 for coordinates.

5. Change the Perimeter to Elements and Select Done.

Create Text Tool
This tool enables you to create text on a pattern or copy.  Text ele-

ments can be set to Plot or Reference on the Attribute Toolbar, but
not to Cut. 

To attach text to a point
1. Use the Snap keys to attach your text to a specific point.

To locate text inside a seam allowance
1. Select the element and right-click inside its seam.  
2. The text will automatically be sized and rotated to fit.

Using the Text Tool to create Size/Date Labels
You can create labels indicating the date each of your patterns was
plotted and cut.  If you have the PatternSmith plugin Grader, you can
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Select the Create Text Tool.  Using the right mouse button, click
where you want the text to appear. Enter your text and the
desired text size in the Create Text dialog box that appears.



also keep your graded patterns organized with labels indicating the
pattern size. 

To enter the date plotted/cut as text
1. Select the Text Tool and type “<date>” in the Text field.  You

can make the text any size and place it anywhere on the pat-
tern, including within the seam allowance.  Click “done” to exit
the Editor and return to the Project Window.  

2. When you are plotting or cutting your patterns, PatternSmith
will automatically insert the current date as text.  Note that the
date feature is only executed when you plot or cut the patterns,
at which point PatternSmith will add that day’s date.
Alternately, if you want the pattern creation date to be on the
patterns, do not type “<date>” onto the patterns.  Simply use
the text tool to enter the date of creation as you would normally
enter text.

To enter the pattern size as text
1. If you’re dealing with patterns that haven’t been graded before,

you may want to grade your patterns first.  Or, you can add the
“<date>” text while creating patterns and then grade the pat-
terns later.  If you wish to grade your patterns first, in the
Pattern View, select the patterns you wish to grade and bring
them into the Grader.  

2. You can either create a new Grade Rule Library for grading
your patterns or you can have your patterns graded according
to an existing library.  (For further information on Grading, see
Chapter 7)

3. Once you have graded your patterns, return to the Project
Window.  From here, click to bring a pattern into the Editor
Window.

4. Select the Text tool and type “<size>” onto each of your pat-
terns.  You can make the text any size and place it anywhere on
the patterns, including within the seam allowances.  

5. Click “Done” to exit the Editor and return to the Project
Window.  Repeat with other patterns.  
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6. Select all these patterns to make graded copies.  Right-click on
one of the patterns.  Click “Properties”.  The Pattern Properties
dialog box appears. 

7. Click on the Grading tab.  Here you can create your graded

copies.  Notice on your graded copies that wherever you typed
“<size>” on a pattern, a size number corresponding to the sizes
you set up appears on the pattern.  

To create a label
1. Select the Create Text tool.
2. Right-click where you want the label, and the Create Text dia-

log appears.
3. Enter the label text, height, and rotation angle.  Press Add Text.

To create a label inside a seam allowance
1. Select the Create Text tool.
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2. Select the element.
3. Position the cursor inside the seam allowance.  When the cur-

sor changes shape, click with your right mouse button.
4. Enter the label text and press Add Text.

Font Text Tool
This tool enables you to choose a font for your text.  Font text ele-
ments can be set to Plot, Reference, or Cut on the Attribute Toolbar. 
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Select the Font Text Tool.  Using the right mouse button, click
where you want the text to appear. Enter your text in the New
Font Elements box that appears.  Choose a desired text size, font,
and style.  Check the “Make each letter an element” box to allow
each letter to be moved or rotated separately from the other let-
ters.  To convert the letters to lines and Bezier curves, under
Convert choose “font to elements”.



To create font text
1. Select the Font Text tool.
2. Right-click where you want the text, and the New Font

Elements dialog appears.
3. Enter the desired label and height, and choose a font and style.

Check the “Make each letter an element” box.  Press OK.
4. You can now move and rotate each letter individually until you

achieve the desired effect.

Create Anchor Point Tool 
This tool lets you attach equally spaced points, circles, or lines to
another element.  If the element moves or changes length, the anchor
points will remain attached to it unless you choose to make the

points separate elements.   You have a choice of attaching drill holes,
circles, or lines to the element.  When you change the length of the
element, the start and end spacing will remain constant, and the
anchor points will be spaced evenly.

To create an anchor point
1. Select the Create Anchor Point tool.

82 PatternSmith 

Select the Create Anchor Point Tool.  Select and then right-click
on the element that will hold the points.  The Create Anchor
Point dialog appears.  Enter the number of points to be spaced
evenly along the element, and the distances from the start and
endpoints to the first and last points.  Choose the style of the
points, and if they are circles, choose a radius.  Click OK.  To con-
vert the points to individual elements, under the convert menu
choose “anchor points to elements”.



2. Left-click to select the element that will hold the anchor points.
Right-click to add the points.  The Create Anchor Points dialog
box appears.

3. Enter the number of anchor points to be equally spaced along
the element.

4. Enter the distance from the start point to the first anchor point,
and from the end point to the last anchor point.

5.   Select the style of anchor points you want.  Click OK.

Create Notches Tool
This tool allows you to add notches to a pattern element at a specified

distance from the element’s start point, midpoint, or end point.
When an element with notches moves, the notches move with it.  If a

83Chapter 2|  Editor Window

Select the Add Notches Tool on the Creation Toolbar.  Right-click
on a selected element to add a notch.  The Create Notches dialog
appears.  Enter the desired settings and click OK.  Left-click and
drag the notch to move it.  



seam allowance is added to the element, the notches automatically
move out to the cut line.  It is easy to move or edit notches at any
time.
For this section, you will need to open Tutorial8.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith \Tutorials

Notch Properties
Each notch has a location (distance from the start
point, midpoint, or endpoint), size, and style.  You
can set the default notch size and style from the
Notch Properties Dialog.  Notches can be Plot or Cut, Internal or
External, and Vee, Tee, Slit,  or Castle.  With PatternSmith, you can
also create a non-standard notch called a Join-Seam notch.  This
notch acts as an extension of the element’s neighbor seam.  This
shows seamers the width of the seam allowance, making it simple to
line up fabric pieces.  

Note: From the Project Window, go to Settings>Notch Settings (or
from the Editor, Options>Notch Styles) to set all notches in a file to
your default notch size and style.  This is particularly useful when
importing files. 

Creating Notches
Before you begin adding notches to your patterns, you’ll want to set
your Default Notch Properties.   
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To set the Default Notch Properties

1. Double-click on the Front Right pattern to bring it into the
Editor Window.

2. From the Editor Menu Bar, select Options and then Notch
Styles.  The Notch Settings dialog box appears.

3. Click Properties.  The Notch Properties dialog box appears.
4. Under the Style tab, select the desired style settings.  For this

tutorial, use the settings shown above.
5. Under the Size tab, type your desired Notch Depth and Width.

(Width only applies to Vee, Castle, and Join-Seam notches).
For this tutorial, set both your Notch Width and Depth to .25.

6. Click the Make Default button, then click OK.
7. Click OK in the Notch Settings dialog box.  Your default notch-

es are set.

To create a notch
1. Bring the Front Right pattern into the editor, and select the

Create Notches tool.  From the Options menu, make sure that
Confirm Notch Location is checked.

2. Select the side seam at the bottom left of the pattern.
3. Position the cursor at the desired notch location on the high-

lighted element.  Right-click.  The Create Notches dialog box
appears.
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4. Select the Distance from Start radio button and enter 3.0.
Note: The start of an element is indicated by a hollow square.
The end of an element is indicated by a dot.

5. Select OK to add your notch.
6. In the same way, add the following notches:

Armscye Bezier curve: 3.0 from end.
Shoulder seam line: 4.5 from start.
Center line:  5.0 from end.

Adding Notches at Specified Distances
You may want to place notches evenly along an element.  You can
specifiy the distance you want between your notches, using this func-
tion similarly to the Add Points at Distance function. 

To add notches at specified distances
1. Select the element where you wish to add notches at a distance.
2. Right-click on the element. 
3. Enter a value in the Distance From Start or Distance From End

box.  This is where your first notch will be placed.
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4. Select Add Multiple notches Every...
5. Determine how far apart you want your notches placed.  Enter

the value in the Add Multiple Notches Every... Box.  Click OK.
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Select the Add Notches Tool on the Creation Toolbar.  With the
left mouse button, double-click the element whose notches you
want to edit.  The Notch Properties dialog box appears.  Make
any desired changes.



Editing Notches
You can move notches to reposition them on an element by left-click-
ing and dragging with your mouse.  You can alsomove, delete, change
style, and copy notches using the Notch Properties Dialog.   

Notch Properties Dialogue Box
The Notch Properties box consists of five columns: Notch Styles,
Anchor Notch to Start, From Start, From End, and Anchor Notch to
End.

Notch Styles
You can change the notch styles by clicking the left mouse
button directly on the notch style column (left-hand column).
Each time you click the mouse button, a different style
appears.  All notches on an element may have the same style
or each may be different.  You can also select a notch, and set
its properties from the Style, Sizes, and Grading tabs at the
bottom of the dialog.

Anchor Notch to Start
Select this radio button to anchor the notch to the start point
of the element (hollow square). This locks the notch at the
distance set between the notch and the element’s start point.
If you change the length of the entity, the notch still remains
the same distance from the start.

From Start
You can set the distance from the element’s start point to the
notch. Edit this distance by clicking on the value, pausing,
and then clicking a second time.  Enter the desired distance.

From End
You can set the distance from the element’s end to the notch.
Edit this distance by clicking on the value, pausing, and then
clicking a second time.  Enter the desired distance.
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Anchor Notch to End
Select this radio button to anchor the notch to the end point
of the element. This locks the notch at the distance set
between the notch and the element’s end.  If you change the
length of the entity, the notch still remains the same distance
from the end.

The Notch Properties dialog box also lets you reverse notch positions.
From this location, notches may be deleted individually, or as a
group.

Reverse All
This function reverses the notches’ distance from the start
and end-point.  The distance from the start point is now the
distance from the end and the distance from the end is now
the distance from the start point.

Remove All
This function removes all the notches from the selected ele-
ment.

Delete
Clicking this button deletes the notch that is currently select-
ed in the Edit Box.
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Construction Guides
Construction guides are useful as temporary snap locations. You can
use the Snap (Ctrl) key to snap to any construction guide, intersec-
tion of construction guides, or intersection of a guide with any ele-
ment.

For this section, you will need to open Tutorial6.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

Normal Guide
The Normal Guide attaches horizontal and vertical snap guides at a
point.

To use a Normal Guide
1. Double-click on Pattern 6A to bring it into the Editor Window.
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Normal Guide: Adds a guide at 0 and 90 degrees.
Two Point Guide: Adds a guide between any two points.
Angle Guide: Adds a guide at any angle.
Tangent Guide: Adds a guide tangent to the selected point.
Distance Guide: Adds a circle giude at a desired radius.
Erase Guides: Removes all guides from screen.
Reset Origin: Lets you move the origin (0,0) to any position.

Construction guides can be created at any point. Left-click to
select an element.  Right-click where you want to attach a guide.
To remove an individual guide, right-click on that guide.  To
remove all guides from the screen, click the Erase Guides tool.



This pattern was digitized into PatternSmith.  You can use con-
struction guides to improve the pattern’s accuracy.

2. Go to the Snap To menu on the Options menu.  Make sure that
Guide Points is checked.

3. Click the Normal Guide tool.
4. Select the left and right vertical lines.
5. Position the cursor over the lower left point of the pattern and

click the right mouse button. (Notice that the cursor shows a
plus and minus sign until it is over the point.  The cursor then
changes to show only a plus sign, indicating that you can add a
guide at that location.)  A guide is added.

6. Add another Normal Guide to the lower
right point.  (The horizontal guide disap-
pears when the second guide is created on
top of the first.)

7. Click the Move/Rotate tool.
8. Select the left vertical line and the top-left

line that attaches to it.  Position the cursor
over their common point.

9. With the left mouse button and the Snap (Ctrl)
key, snap the common point to the nearest loca-
tion on the guide.  (Make sure to press the left
mouse button before the Snap key.)  The left line
is now vertical.

10. Select the right vertical line and the Bezier curve.
11. Snap them to their guide as you did on the left side. The right

line is now vertical.
12. Click the Remove Guides button to clear the guides.

Tangent Guide
The Tangent Guide attaches snap guides that are tangent and per-
pendicular at the point you select.

To use a Tangent Guide
1. Select the Tangent Guide tool.
2. Highlight the top line and the right vertical line.
3. Using the right mouse button, add a tangent guide at the right
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endpoint of the top line, where it attaches to the Bezier curve.
The Tangent Guide Offset Preset dialog box appears.

4. Leave the offset at 0.0 and click Set.
5. Create a second tangent guide where the right line attaches to

the Bezier curve.  Again, leave the offset at 0.0.
6. Select the Move/Rotate tool.
7. Highlight the Bezier curve to

make the handles appear.
You may need to use the
Zoom Tool to zoom out to
access the handle endpoints.

8. Snap the handles of the
Bezier curve to the tangent
lines you created.

9. Use the Erase Guides button to
clear all of the guides.

10. Set the perimeter to Use Elements
and click Done.  Your pattern now
matches the version below it in the
Project Window.

Distance Guide 
The Distance Guide attaches a circle snap guide at the point you
select. This tool is useful when you need to triangulate from meas-
ured lengths to create a portion of a pattern.

To use the Distance Guide
1. Double-click on Pattern 6B to bring it into the Editor Window.
2. Go to the Snap To menu on the Options menu.  Make sure
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Intersection Points is checked.
3. From the Options Menu, make sure the units are in inches.
4. Select the Distance Guide tool.
5. Highlight the horizontal line inside the rectangle.
6. Click the right mouse button on the left end point of the hori-

zontal line. The Create Circles Guide dialog box appears.
7. Enter 18.00 for the Radius, and select Create.
8. Now add a Distance Guide, with

radius 14.00, to the right end of the
horizontal line.

9. Select the Create Lines tool.
10. Using the right mouse button and the

Snap key, create a line that connects
the left endpoint of the horizontal line
to the intersection of the two circle
guides.

11. Now snap a line from the intersection of the circle guides to the
right endpoint of the horizontal line

12. Click Done.  Your pattern matches the one below it.

Angle Guide
The Angle Guide creates guides at any angle. Click the right mouse
button on the tool to set the angle you want.

To use the Angle Guide
1. Double-click on Pattern 6C to bring it into the Editor Window.
2. Select the Angle Guide tool.
3. Select the horizontal line inside the rectangle.
4. Position the cursor over the left endpoint and click the right

mouse button. The Create Angle Guide appears.
5. Enter a 50° angle and click Create. The Angle guide appears.
6. Now add an angle guide at 120° to the right endpoint.
7. Select the Create Lines tool.
8. Snap one line from the left endpoint to the intersection of the

two angle guides, then another line from the right end point to
the intersection of the two angle guides.  Your pattern now
matches the pattern below it in the Project Window.
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Fullness Toolbar
The fullness functions let you add shape to a flat pattern, through the
use of darts and pleats.  

Slash and Spread
Before inserting a dart, you must create an opening in the pattern
perimeter.  The Slash and Spread tool lets you “cut” your pattern and
then spread it at the slash line and/or rotate it about an anchor point.
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Slash and Spread
Create Dart
Dart Transfer
Create Pleat

Click on the Slash and Spread tool.  Select the two perimeter ele-
ments that will be cut by your slash line.  With the right button,
slash a line across both elements just as you would draw a line.
The Snap (Ctrl) key may be used to snap one or both ends of the
slash line to specific points on the perimeter.  The Slash/Spread
dialog box appears.  Designate the desired amount of spread
and/or rotation.  To spread the pattern evenly along the slash
line, click Slash and Spread and then enter the desired amount of
spread.  To rotate about the anchor point (first point on your
slash line), click Slash and Rotate.  Enter the number of degrees
of rotation or the desired amount of spread at the element oppo-
site the anchor point.  (Remember that you can choose either or
both of these options.)
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For this section, you will need to open Campshirt_Graded.pat, locat-
ed in the following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

To open a pattern perimeter using the Slash/Spread tool
1. Double-click on the Left Front pattern (campshirt) to bring it

into the Editor Window.
2. Select the Slash and Spread tool.
3. Using the left mouse button, select the left vertical line (bot-

tom) and the angled right line (shoulder) on the pattern
perimeter.

4. Right-click near the midpoint of the left line, and then right-
click near the midpoint of the right line.

5. In the dialog box, select Slash and Rotate, and set Distance to
1.0 inches, and click OK.
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Create Dart
You can insert a dart into any opening in a pattern perimeter. Use the
Snap key to attach the dart to the endpoints.  You can create a regu-
lar dart or a curve dart, which allows you to shape the sides of your
dart.  In apparel design, curve darts can make a nicer, smoother
seam, as well as make for easier sewing.

Note: Remember that because perimeters have a counter-clockwise
direction, you must begin the dart at the endpoint of an element, and
finish at a startpoint.  This maintains the counter-clockwise perime-
ter direction.

To insert a dart
1. Select the Create Dart tool.
2. Holding the Snap key down, right-click on the endpoint at the

bottom of the gap.
3. Still holding the Snap key, right-click on the startpoint at the

top of the gap.  The Create Dart dialog box appears.
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Select the Create Dart tool.  Using the Snap key, right-click on the
element endpoint by the gap and then on the element startpoint
near the gap.  The Create Dart dialog box appears.  Enter dart
Depth and Backoff offset.  Check Fold CCW to designate a count-
er-clockwise fold for the dart.  Leaving this box unchecked desig-
nates a clockwise fold for the dart.  To easily locate the apex on
your material, check Add Point at Apex.  Choose Plot, Cut (drill
hole), or Reference as the Point Plot Type.  Click OK.
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4. Set the dart Depth to 7.0 inches and the Backoff offset to 2.0
inches.  Select the radio button to make your dart a Fold dart,
and set the fold to CCW (counter-clockwise).  Click OK.
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To insert a curve dart
1. Select the Create Dart tool.
2. Holding the Snap key down, right-click on one of the endpoints

where you spread your material.
3. Still holding the Snap key, right-click on the point at the other

side of the spread.  The Create Dart dialog box appears.  

4. Enter the desired dart depth and Backoff offset.  Select the
radio button to make your dart a Notch dart.  Click OK.  You
will see a point on one side of the dart.  This is a handle.
Position the cursor over the point and it changes to a crosshair.  

5. Left-click and drag the mouse.  You will see the dart bow in and
out.  Position the dart as desired.
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Dart Transfer
The Dart Transfer tool enables you to transfer a portion of a dart to
another element.  

To transfer a dart
1. Select the Dart Transfer tool.
2. With the left mouse button, select the dart and the top horizon-

tal line.
3. Right-click on the Rotation Point of the dart.
4. Right-click on the selected element, at a good location for the

new dart.  The Dart Transfer dialog box appears.
5. Enter the %

of the dart to
transfer and
the Backoff
for the new
Dart.  Click
OK.
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Using the Dart Transfer tool, select the dart you want to modify
and the element to which you want the dart transferred.  Right-
click on the dart rotation point and then right-click at the desired
location for the new dart.  You use the Snap key to snap the new
dart to a specific location.  The Dart Transfer dialog box appears.
Enter the amount of the dart to transfer and the depth of the new
dart.  Click OK.



Create Pleat
The Create Pleat tool lets you insert a pleat between any two ele-
ments on the perimeter of a pattern.

To insert a pleat
1. Bring the Front Right pattern into the Editor Window.
2. Select the Create Pleat tool.
3. Select the two perimeter elements that will be pleated.
4. Right-click at the desired Start of the pleat.
5. Right-click at the desired End of the pleat.  The Insert Pleat

dialog box appears.
6. Select the pleat Style

and Fold direction
(counter-clockwise or
clockwise).

7. Enter the Pleat Width
at the Start and Pleat
Width at the End.
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Click the Create Pleat tool.  Select the two perimeter elements
that will be pleated.  Right-click near one of the elements and
then drag a pleat line to the other element.  The Snap key may be
used to snap the pleat to existing points.



Three-Dimensional Pipe Intersecting
With PatternSmith, you can create accurate two-dimensional pat-
terns for three-dimensional pipes or tubes, including their intersec-
tions.  You can create intersections at angles or at Tees.
(PatternSmith lets you create patterns for basic pipes, but if you want
to create much more complex intersections, get the PatternSmith
plugin Pipes 3D.)

Create Pipe Intersections at an Angle
Follow the directions below to create patterns for two intersecting
pipes or tubes.  You’ll begin by designing rectangular patterns, which
you will then modify through PatternSmith to make your pipe pat-
terns.  With PatternSmith, this potentially complex process becomes
simple!

To Create a Pipe Intersection at an angle:
1. With nothing selected in the Project View, double click to enter

the Editor Window.
2. Create a rectangle with a height equal to the circumference of

your pipe and width equal to the length of your pipe.  
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Note: 
Circumference = 2 (pi) x radius OR pi x diameter

3. Select all the sides of the rectangle (Ctrl + A) and then break all
the lines at the corners (Ctrl + B).

4. Select the side of the rectangle where the intersection will be.
5. From the main menu, click Convert>Create Pipe Intersection.

The Pipe Intersection Dialog Box appears.

6. Select Angle Change and enter the angle you want between the
pipes as they intersect.

7. The line you selected in the Editor on the rectangle is now a
reference line, and a new polyline is added reflecting the angle
of your pipe intersection.  You have now created half of your
pipe intersection.  You may duplicate (Ctrl + D) the pattern you
just created, or you can repeat the process described above if
you want the other half of the intersection to be longer or
shorter.
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Create Pipe Intersections at a Tee
Follow the directions below to create patterns for two intersecting
pipes or tubes.  You’ll begin by designing rectangular patterns, which
you will modify to make your pipe patterns.

To Create a Pipe Intersection at a Tee:
1. With nothing selected in the Project View, double click to enter

the Editor Window.
2. Create two rectangles - one for the Main Pipe and one for the

Intersecting Pipe, as shown on the previous page.  Create them
with heights equal to the circumferences of your pipes and
widths equal to the lengths of your pipes.  

Note: 
Circumference = 2 (pi) x radius OR pi x diameter

3. Select all the sides of the rectangle (Ctrl + A) and then break all
the lines at the corners (Ctrl + B).

4. Select the side of the rectangle where the intersection will be.
5. From the main menu, click Convert>Create Pipe Intersection.

The Pipe Intersection Dialog Box appears.
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6. Select Tee Intersection and enter the radius of your Base Pipe
(the pipe your Intersecting Pipe is intersecting).

7. The line you selected in the Editor on the rectangle is now a
reference line, and a new polyline is added reflecting the angle
of your pipe intersection.  Now you need to cut a hole in anoth-
er pipe to accomodate the intersecting pipe you just created.   

8. In the rectangle you created for the Base Pipe, using the Create
Plot Point tool, create a plot point where you wish the intersec-
tion to take place.  The plot point will be the center of the
cutout for your intersection.  

9. With your plot point selected, go to Convert>Create Pipe
Intersection.  

10. Enter the radius of the intersecting pipe and the radius of the
base pipe.

11. Select the orientation of the base pipe.  When you are orienting
your cutout, you are simply rotating the hole.  The intersection
angle between the pipes remains at 90 degrees.  

16. Click OK.  Your patterns for intersecting pipes are finished.
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Automatic Replacement Toolbar
The Automatic Replacement Toolbar makes perfect patterns even
easier than before.  These tools are ideal for converting Gerber cut
files or digitized patterns into PatternSmith patterns quickly and eas-
ily.  With one mouse click, polyline notches can be converted to notch
elements, corners can be broken, seam allowances can be set, and
polylines can be replaced with lines, arcs, Beziers, and fillets.

For this section, you will need to open Tutorial14.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

The Automatic Replacement Toolbar lets you edit patterns one ele-
ment at a time by using the individual editing tools or all at once by
using the Auto Replacement Wizard.

Before you can use any of the Auto Replacement tools you need to
configure the replacement tolerance settings.
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Auto Replace Wizard
Break Notches/Corners
Move in by Seam Allowance
Rotate to Horizontal/Vertical
Line Replacement
Arc Replacement
Bezier Replacement
Fillet Replacement
Auto-Thin



Configuring Auto Replacement Settings
Whenever an Auto Replacement function finds a polyline that can be
replaced with a smoother line, arc, Bezier, or fillet that is still within
the tolerance you have specified, it will make the replacement.  You
can create any number of different configurations for replacement,
and save them by name.

To configure the tool, no elements need to be selected.  Right click on
the Wizard button to open the configuration dialog.  
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Here you can set tolerance parameters to determine how you want
PatternSmith to improve your patterns.  You cannot change the
“Default” settings, but you can create a custom configuration by
selecting “New Data” and setting new values under each tab.  Then
choose a name for the settings you’ve chosen so that you will be able
to easily use all of them again.

General
This tab lets you select which functions you want performed
automatically when you click the Wizard button.  For this
tutorial, turn off the Seams and Fillets as shown.  

Corners
You can set the minimum and maximum angle changes to be
changed to a corner (or breakpoint).  For this tutorial, set the
minimum to 20 degrees, and the maximum to 160 degrees.   

Seams
You can automatically move the elements in by any seam
allowance value.  Each configuration you create can have a
different value.

Notches
If notches are included as polylines, you can replace them
with notch elements, which can be easily moved or changed.
Make your settings as close as possible to the notches that
exist in the pattern.  You can replace them with notches the
same size as the pattern (but notch elements, which are easily
moveable) or with the notch that you have set as the default.
For this tutorial, set up the notches tab as shown on the fol-
lowing page.

107Chapter 2|  Editor Window



Element Alignment
When an element is very close to horizontal or vertical, you
can have it automatically aligned to zero degrees.  It is usually
best to have the program reconnect for you by extending or
trimming. 
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Lines, Arcs, Bezier Curves
For each of these element types you can set the average devia-
tion and the maximum deviation.  For this tutorial, set the
average to .06” and the max to 0.10”.  Any polyline within
those parameters will be converted to a line, arc, or Bezier
curve in that order of preference.   

Fillets
A fillet is an arc that is tangent to each of its neighbors.  Set
the average deviation to 0.06” and the max to 0.10”.  The tool
will attempt to fit an arc first, then a Bezier fillet.

Thinning PolyCurves
If a polyline can’t be fit with a smoother element type, it can
still be smoothed by thinning.  The resulting polycurve will
not depart from the original by more than the deviation you
set.  It is often best to set the deviation to a conservative (low)
value and do the final thinning by hand.  For this tutorial, set
the deviation to 0.03”. 

To Configure the Auto Replacement Wizard
1. Double-click on the bottom right pattern to bring it into the

Editor Window.
2. Without selecting any elements, notice that the Auto Replace

Wizard button is lit on the Auto Replacement Toolbar.  Right-
click on the Wizard tool to open the Configuration dialog.  Set
all the deviation values as described above.

3. Save your Configuration as “Tutorial14”.
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To Use the Auto Replacement Wizard
1. Without selecting any alements, left-click on the Auto Replace

Wizard tool.  The Confirm Notch Locations Dialogue appears.
The Auto Replace Wizard has located all of the notches in the
pattern successfully.  If any notches were missed, you can right
click on the pattern to place a notch, and fine tune the position
in the upper left drawing area.

2. Click “Replace.”  The Auto Replace Wizard has replaced the
pattern elements with PatternSmith notches.  
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3. The Confirm Corner Locations Dialogue appears.

4. Right-click on the pattern where shown to add a corner where
the Auto Replace Wizard did not detect one.  Then, manipulate
the corner location in the smaller box in the left corner.  Snap
the circle to the point shown.  Click “Replace.”  The Auto
Replace Wizard has replaced the pattern edges with accurate
corners, as well as adding the corner you specified.  
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5. Confirm each replacement for lines, arcs, and Bezier curves.
You have an accurate, finished, PatternSmith pattern
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Editor Menus
Some important functions are found only on the menus and are not
repeated on the toolbars.

Edit Menu

Copy to New Pattern:
This function enables you to create a new pattern based on the shape
of another pattern.  It also lets you separate patterns from a group,
such as from an imported AutoCAD drawing.
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Select the elements you will use to make the new pattern and
click “Copy to New Pattern” on the Edit menu.  A dialog box
appears.  Enter a name for your new pattern.  Indicate whether
you want the selected elements removed from the current pat-
tern.  Select the desired perimeter type.



Scale All/ Scale Selection:
These functions let you scale an entire pattern or selected elements of
a pattern.  Seam allowance widths do not change when you scale ele-
ments or patterns.

Convert Menu
From the Convert menu, lines and polylines can be converted to arcs.
Arcs and Bezier curves can be converted to lines or polylines.  You
can convert multiple selected elements at one time. 
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From the Edit menu, select Scale All or Scale Selection.  Enter the
X and Y scale factors.  Indicate if you want PatternSmith to scale
the text.  Click Rescale. 



When you convert an arc or Bezier curve to a polyline, you can deter-
mine the frequency of points along the polyline.  A low Curve Fit
Deviation produces more points than a high deviation.  If you are not
satisfied with the results of your conversion, simply press the Undo
button and try a different Curve Deviation value.
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Select an element(s).  From the Convert menu, indicate what ele-
ment type you want your selection to become.



Transform Menu

Break Notches
In Gerber cut files, notches are included as part of a continuous poly-
line.  The Break Notches function lets you separate them as line or
polyline elements.
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Select an element.  From the Transform menu, select Break
Notches.  A Break Notches Settings dialog box appears.  Enter the
minimum and maximum lengths and angles that describe your
notches.  PatternSmith now recognizes these as independent ele-
ments.



Break Corners
The Break Corners command automatically breaks a selected poly-
line(s) when the angle change between polyline segments is greater
than 45 degrees.
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Fit Editor 
In the Fit Editor, you can edit several pat-

terns at one time and ensure their perfect

fit.  Attach the patterns along their edges

and make any needed adjustments.  Make a

common alteration to several patterns at

once.  Use Notch Rulers to position your

notches quickly and accurately.
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Starting the Fit Editor

Fit Editor Toolbar
Moving, Rotating, Snapping
Panning Elements
Move Relative Function
Adjusting Pattern Elements

Notch Rulers
Connecting Notch Rulers
Ease
Aligning Notches
Notch Properties Dialog



Starting the Fit Editor

For this section, you will need to open campshirt.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

To Bring Multiple Patterns into the Fit Editor
1. Hold down the shift key and select the following patterns: Left

Front, Right Front, Sleeve, and Back.
2. Select the Edit Pattern button. The patterns are now in the Fit

Editor.

Select more than one pattern in the Project Window and click the
Edit button.  Your patterns are now in the Fit Editor. 
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Fit Editor Toolbar

Moving, Rotating, and Snapping
Elements are moved in the Fit Editor just as they are in the Editor
Window.  The Snap function is always working in the Fit Editor.
Patterns points can be snapped to another point.  Elements can be
rotated and snapped to another element.  
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Move/Rotate: Selects, moves, or rotates patterns and elements
Print: Prints the patterns currently in the Fit Editor
Save: Saves as you continue working in the Fit Editor
Zoom All: Brings all patterns into view in the Fit Editor Window
Zoom: Zooms in (left mouse button) or out (right mouse button)
Pan: Moves all patterns to recenter the view
Undo: Retracts your last action
Redo: Recreates undone actions

Editor: Takes selected pattern into the Pattern Editor
Show Seams: Toggles to show or hide the seams of the patterns
Home Patterns: Places all patterns in their original position
Move Relative: Moves selected elements in X and Y directions
Set Length: Changes the length of any element
Measure: Measures the distance between two points
Text Tool: Enables you to create text on your patterns



To Snap One Pattern to Another
1. Click the Show Seams / Hides Seams button to hide the seam

allowances. Select the Left Front pattern.  
2. Click and hold the left mouse button on the point where the

bottom Bezier curve and the right vertical line are joined on the
Left Front pattern.

3. Drag the point until it snaps to the top right point of the Back
pattern.

4. With the Left Front pattern still selected, click and hold the
right mouse button on the point where the two patterns are
joined.  Rotate the pattern until the matching elements snap at
their tangents. 
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Click the Hide Seams button.  Select a pattern.  Left-click and
drag a point until it snaps to another point.  Right-click and drag
to rotate the pattern and snap it to another element.

Back Left Front

Right FrontSleeve



5. In the same way, snap the Right Front pattern to the opposite
side of the Back pattern.

6.  Move the Sleeve over to be aligned.  Right-click in the center of
the Sleeve and rotate it into position.

Panning Elements
When you have zoomed in to edit a specific element and then need to
see another section of the pattern, use the Pan tool.  Click the Pan
button.  Left-click and drag to move the desired area into view.  (The
space bar also turns the Pan button on and off.  Click and hold the
space bar while you drag a new area into view.) 

Move Relative Function
The Move Relative tool is used to move selected elements by speci-
fied distances.  All elements attached to the element(s) being moved
are stretched or shortened so they remain attached.  You can select
one element on each of several different patterns.  Using the Move
Relative tool enables you to lengthen this group of patterns by the
same amount at the same time, still maintaining closed perimeters.

Notice that the Move Relative tool behaves differently in the Fit
Editor than the same tool does in the Editor Window.  In the Editor
Window, an individual element is moved and the perimeter is bro-
ken.  In the Fit Editor, pattern perimeters always remain connected.

To Move Elements in Multiple Patterns
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Select the elements you need to move.  Click the Move Relative
tool.  Enter values for your desired changes in X and Y.



1. Click the Home Patterns tool button to bring the patterns back
to their original position.

2. Using the Shift key, select the left vertical line on the Back, Left
Front, and Right Front patterns.

3. Select the Move Relative tool. The Incremental Move dialog
box will appear.

4. Type in –2.00 for Delta
X and 0.00 for Delta Y,
and click Move. Each
selected element will
move 2 inches to the
left.

Adjusting Pattern
Elements

In the Fit Editor, when you select an element on an already selected
pattern, you see the “handles” for that element.  Left-click and drag
these handles to smooth curves where the pattern pieces meet.

If you need to do more extensive modification to a pattern, select it
and then click the Editor button.  This takes you to the Editor
Window.  To return to the Fit Editor window, click Done or Cancel
on the Editor Menu Bar.

We’ve added a Set Length tool in the Fit Editor.  This allows you to
edit an element’s length right in the Fit Editor as you work for the
best fit between patterns.  This tool works in a manner similar to the
Length Tool in the Editor, except that it always modifies an element’s
neighbor elements to accomodate the change in length as well as the
original element itself.

Chapter 3|  Fit Editor 125



Notch Rulers 
Notch Rulers are a very powerful tool in the Fit Editor.  They enable
you to align the notches of one pattern to those of another pattern
and to allow for ease in one or more elements.  To see an element’s
notch ruler, simply double-click on the element.

Connecting Notch Rulers
To align notches on joining elements, you must first connect the
notch rulers.  Notch rulers can be connected end to end or edge to
edge, exactly as you would sew the patterns together.  Move a notch
ruler by left-clicking inside the length bar and dragging.  When you
are close enough to another ruler, the dragged ruler will snap into
position.

If two or more elements will be sewn together end to end, snap their
ruler ends together.  If elements will be sewn together edge to edge,
rotate one ruler and then snap it to the other, edge to edge.

Note: Elements and their notch rulers have direction and must be
connected in the proper order. 

Each element in a pattern perimeter has a direction, arranged so that
the completed perimeter’s direction is counter-clockwise.  As you
move from a perimeter element’s start point to its end, you will
always be moving in a counter-clockwise direction.
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Ease Bar
Notches



Notch rulers also have Start and Finish ends.  When you first bring
up an element’s notch ruler, the Start end is on the left – regardless
of the position of the element in the Fit Editor window.  Notice that
the ruler’s rotate button is always the Start end and the close button
is always the Finish end.

If elements will be sewn together end to end, notch rulers must be
ordered from left to right so the counter-clockwise direction remains
continuous.  In the drawing below, the Back armscye notch ruler
must be to the left of the Front armscye.
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If elements will be sewn together edge to edge, the notch ruler of one
must first be rotated so the notches face each other.  (The program
will not let you snap two notch rulers together edge to edge until one
is rotated.)  To join the notch rulers for the patterns above, the Sleeve
top ruler must be rotated in order for its finish point to coincide with
the start point of the back armscye.

To Connect Notch Rulers
1. Snap the Back and Right Front patterns together as shown in

the diagram on the previous page.  Bring the Sleeve pattern
into position.

2. Double-click the left mouse button
on the Bezier Curve of the Back
pattern.  The notch ruler appears.

3. Double-click on the Bezier Curve of the Right Front pattern to
view its notch ruler.

4. Click, hold and drag the Right Front notch ruler and snap it to
the right side of the Back notch ruler.

5. Double-click on the top of the Sleeve pattern to view its notch
ruler.  Click the Rotate button on the Sleeve notch ruler.

6. Snap the Sleeve notch ruler to the bottom of the Back and Left
Front notch rulers.
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Double-click on an element to view its notch ruler.  Connect
notch rulers of adjoining elements, either end-to-end or edge-to-
edge, making sure that the counter-clockwise direction is main-
tained.



Ease
To allow ease, an element may be designed so it is longer than its
adjoining element.  The ease bar on each notch ruler lets you adjust
for this ease. 

To Insert Gather on a Notch Ruler
1. Click on one of the ease arrows on the longest Notch Ruler.
2. Move the arrows apart to indicate the area in which the ease is

to be distributed.

Aligning Notches
Notch rulers enable you to align the notches of one pattern with the
notches of another.  The gray lines in a notch bar indicate the notch
locations in an attached notch ruler.
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Click on the ease bar’s arrows.  The notch ruler is automatically
shortened to match the length of its snap neighbor.  Left-click
and drag the arrows to indicate the area in which the ease should
be apportioned.  PatternSmith adjusts the scale factor in the ease
area to account for the extra material.

Left-click and drag a notch handle until it snaps to the appropri-
ate gray line (notch of the attached notch ruler).



To Align Notches 
1. Left-click and drag one of the notch handles on the Sleeve

notch ruler to snap it to the nearest gray snap line. 
2. Snap the other notch handle to the other snap line.

3. In the same way, align the notches on the other armscye ele-
ments to the new Sleeve notch locations.  (Be careful to main-
tain the counter-clockwise direction as you connect notch
rulers.)

Notch Properties Dialog
The Notch Properties dialog may be accessed in the Fit Editor win-
dow.  (This dialog may also be reached from the Pattern Editor.)
Here you can add, delete, and locate notches.  
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Right-click on the notch slider bar or on a notch handle in a
notch ruler.  The notch menu appears.  Click to add or delete a
notch or to copy and paste all notches to another element.  Click
on Properties to bring up the Notch Properties dialog.



The Notch Properties dialog is the same as the dialog in the Editor
Window.
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Smoothing Selections
The ability to smooth a selection is a powerful tool in the Fit Editor.
With this function, you can transform a group of lines snapped
together into a smooth series of connected Bezier curves.

For this section, you will need to open SmoothEdgeTutorial.pat,
located in the following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

To Use the Smooth Selected Function
1. Select the series of patterns on the right.  Click the Editor but-

ton to bring the multiple patterns into the Fit Editor.
2. Left-click on the upper left endpoint of the second pattern

piece and drag it up to snap it to the lower right endpoint of the
top pattern piece.  (The elements snap automatically in the Fit
Editor; you do not need to use the Snap key.)
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Select a series of connecting line elements.  From the Edit menu,
click Smooth Selected.  The selected lines are smoothed into a
seeries of connected Beziers.



3. With the pattern pieces snapped together, right-click on the
same point and rotate the second pattern piece to snap to the
top pattern piece.  The pattern pieces are now tangent to one
another.

4. Snap the third pattern piece to the second; rotate it to be tan-
gent.  Continue snapping and rotating until all the pattern
pieces are snapped together.
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5. Hold down the Shift key and select the base line of each pattern
piece (the lines that now make up a curve).  From the Edit
drop-down menu, click Smooth Selected.  The lines are con-
verted to a series of smoothly connected Bezier curves, with
one continual curve shape.

6. Click Done.  PatternSmith asks if you want to save your current
view as a pattern.  Click Yes.  Saving your current view as a pat-
tern means you can later use it as a template to create facings
or patches.  Enter a pattern name.  Your newly created pattern
is now seen in the Project Window.  You will see that it match-
es the tutorial pattern that had already been created. Because
you saved the view as a new pattern, the old pattern pieces are
kept unaltered in the Project Screen.
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Nesting 
With PatternSmith, nesting is a simple

“drag and drop” operation.  Pattern proper-

ties and constraints are set, materials are

specified, and then patterns are nested.  
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Pattern Properties and Constraints
A pattern’s properties are set from the Pattern Properties dialog box.
These properties include the pattern’s name, size, rotation con-
straints, fill colors, quotas (number of copies required and made),
and revision history.

For this section, you will need to open Tutorial9.pat, located in the
following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

General Properties
The General tab tells you the pattern name, the perimeter and area of
your pattern, and the total number of copies nested to the Table
(Nesting View).  The pattern name may be changed from this dialog
box.
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To open the Pattern Properties dialog box, select a pattern in
Pattern View, right-click on the pattern, and then click
Properties.  To set the same properties for more than one pattern
at a time, use the shift key to select multiple patterns, then right-
click inside one of the selected patterns. 



Rotation
The rotation tab lets you set the initial rotation angle of your copies
and determine the amount of rotation that will be permitted in the
Nesting View.

Initial Copy Rotation
A pattern’s position in the Editor window establishes its 0° rotational
angle. It is often helpful to rotate patterns in the Pattern View, how-
ever, so you can easily see the pattern’s location in the finished prod-
uct.  This rotation does not affect the pattern’s original rotational set-
ting.

When nesting patterns, you can choose to have Patternsmith create
your copies at 0° rotation (angle in the Editor window), or at the cur-
rent pattern rotation (as seen in Pattern View).  You can also choose
to have the current Pattern View rotation set as zero.
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Rotation Constraint
You can allow a pattern to be rotated to any angle, or constrain its
rotation to +/- 90 or +/- 180 degrees.

Allowable Tilt Angles
If you have constrained rotation, you can still allow a small tilt angle
by checking the Add Tilt box and entering the desired angle of tilt.
To add tilt while rotating, hold down the Control key while you rotate
with the right mouse button.  As an example, if Tilt is set to 5° and
the Rotation Constraint is set to +/- 90°, the pattern can be rotated
from 85° to 95°.

Set Current Rotation as Zero
You can choose to have the current Pattern View rotation of a pattern
set as zero.  This is similar to setting an origin or a Home.  Click the
box for Set Current Rotation as Zero, and the pattern’s current posi-
tion becomes zero.  The pattern will now be viewed at that rotation in
the Editor, and nested copies will be created at that angle.

Fill Colors

Patterns and copies can be filled with any color your choose.  This
option makes it easy to color code patterns of a specific size or type.
Alternatively, patterns may be filled with the color of the material on
which the first copy is placed.  This is a convenient way to be sure
that each pattern was copied to the correct material.
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Quotas

Copies Required
Set the number of copies you need for each pattern.  If you check the
Don’t Exceed Quota box, PatternSmith will not allow you to make
more copies than your quota.

Quota Multiplier 
When you need to make multiple sets of the patterns in a project, set
the Quota Multiplier to the number of sets required.

Revision History
Each time you edit a pattern, you are given the opportunity to add a
comment to the Revision History.  The History Tab lets you review all
the changes made to any pattern.
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Notches
View and edit your pattern’s notches from the Notches Tab.

Materials
Copies of your patterns will be made onto specified materials and
tables.  You can nest copies on as many materials as you need, with
each material having as many tables as is required.  

The Materials Toolbar in the Project Window shows which material
is in use, the material width, and the current table number.  The
Nesting View reflects the material in use also.

Material Library
For convenience, all of your materials can be kept in a Material
Library.  In the library, they can be quickly retrieved or modified.
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All of the materials in the library are shown on the right side,
arranged into groups for convenience.  The materials in the current
project are shown on the left side.  Each material is defined by width,
color, pattern, and Plot / Cut / Text speeds.
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To view the Library, select the Library button on the Materials
Toolbar.  (Alternatively, from the Material menu on the Editor
menu bar, select Material Library.)



To Create a New Material
1. Click the New Material button on the Project side of the win-

dow.  A new material named Default is added, with all of its
properties set to default values.

2. To view the settings, click the left mouse button on the + in
front of the new Default material.

3. Click on the name (Default) and change it to MyMaterial in the
top edit box.

4. Click on the Plot Speed and, in the edit box, change its value to
10.0.

5. Click the Select Color button.  Choose the color you want from
the Color Palette.

6. If necessary, click on width and change its value to 60.0 inches
in the edit box. 

Note:  To make a material automatically available for all new proj-
ects, select that material on the library side and click Make Default.
A check appears in front of the selected material, indicating that it is
now a default material.  (Clicking again on the Make Default button
reverses the default action and the check disappears.)
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To use a specific material for nesting, you must copy it from the
Library to the Current Project.  Highlight the desired material
and press the appropriate Copy button in the center.

To modify a material’s characteristics, click the + in front of the
material’s name.  Highlight the item you want to modify and then
change its value in the top edit box.

To delete a material from either side, select the material and
press the Delete key on your keyboard.



To Copy a Material 
1. Select MyMaterial on the project (left) side.  
2. Click the Copy>> button in the center to copy the material to

the library.
3. Select a material from the library (right) side.
4. Click the <<Copy button in the center to copy the material to

the project.
5. Click OK to return to the Project Window.
6. Click inside the Material Name combo box and select

MyMaterial.  The Nesting view is now empty.

Creating and Nesting Copies
Patternsmith lets you easily place copies of patterns on a table of
material.  Copies may then be quickly nested, using a variety of tools
that will make possible the most efficient use of your material.

Creating a Copy
Pattern copies may be created on a material selected from the
Materials Toolbar.  If you are working with more than one table of
this material, you can indicate the table number for the copies you
are making.

If you have set a quota for a pattern, and checked the “Don’t exceed
quota” box, the program will not allow you to make more copies than
your quota.  A message box informs you that your quota has already
been reached.
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On the Materials Toolbar, select a material and indicate the table
number you will be nesting.  Left-click, hold, and drag a pattern
from the Pattern View to the Nesting View.  When you release the
mouse button, the copy appears.  Notice that in Pattern View, the
pattern you copied is now filled with color.  (This color is deter-
mined in the Pattern Properties Color tab.)



To Make Copies
1. Click in the Material combo box, and select MyMaterial.

2. Make sure the table number is set to 1.  If not, use the up or
down arrows to go to table 1, or type a 1 into the Table edit box. 

3. Using the left mouse button, click, hold, and drag one of the
patterns from the Pattern View down to the Nesting View.
When you release the mouse button, a copy is placed in the
Nesting View (table) at that point. 

Distance between Copies
In the Nest Settings dialog box, you may determine how closely your
pattern copies will be nested (inter-copy spacing) and how close they
will be placed to the material edges.  Different copies may have dif-
ferent inter-copy spacing settings.  The spacing values may be
changed while you are working on a project.  All subsequently nested
copies will be spaced according to the new setting.
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From the Settings menu, click Nesting Setup.  Enter the desired
spacing distance from the material edge and between patterns.  



Inserting Bump Lines
A Bump Line is a vertical gap between groups of nested copies.

Nesting Modes
PatternSmith provides two different nesting modes. Move Freely
Mode allows you to locate a copy anywhere on the table, even over-
lapping another copy.  The copy may be rotated within the assigned
rotation constraints.  Nestle Mode also allows you to position copies
on a table, but prevents them from overlapping other copies.  It also
lets you drag a vector to indicate the direction you want a copy to
move.

While moving a copy, press the Space Bar to change nesting modes.
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Move Freely Mode
Use the left mouse button to drag a copy to a desired location on
the table.  (It may overlap other copies.)  Click and hold the right
mouse button, and move the mouse from side to side to rotate
the copy. 

Nestle Mode
Use the left mouse button to move a copy to a desired location.
With the right mouse button, click, hold and drag a vector.
When you release the mouse, the selected copy moves as far as
possible in that direction.

From the Table menu, click Insert Bump Line.  Use the left
mouse button to drag the bump line to any location.



To Nest Copies 
1. Select Nestle Mode so copies will not overlap one another.
2. Drag copies of the patterns down to the table, arranging your

copies to look like the diagram.  Practice drawing vectors with
the right mouse button to indicate the desired direction of
movement.

3. Click the Table Up arrow on the Material Toolbar
to prepare to place copies on Table 2.

4. Nest the remaining
pattern copies to
Table 2, positioning
them like the dia-
gram to the right.
Use the right-button
vector to nest them
tightly together.

149Chapter 4|  Nesting



Memory Nesting
The Memory Nest function is very useful when using the Grader and
nesting multiple sizes of the same pattern.  Memory Nesting allows
you to memorize the position of patterns nested in the nesting view.
Then, when you nest a new table with new sizes, the patterns will be
positioned in the same location as the previous patterns.  You may
still need to manually re-position a few patterns for the best fit, but
this function will save you the time of dragging and positioning each
pattern individually in the nesting view.  

To use the Memory Nest Function 
1. Using graded patterns, in the Project Window nest one table of

pattern sizes, positioning each pattern in the desired location.
Select all of the nested patterns.

2. From the Tools menu, select ‘Memorize Marker’.  
3. Go to a new table of the same patterns, graded in a different

size.  Select these patterns.  
4. From the Tools menu, select Memory Nest.  All your new pat-

terns are nested in the new table, in the same orientation as
your original table.  Because the sizes are different, you may
need to adjust the patterns slightly to avoid overlaps or to
obtain the best material efficiency.
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Nest a table of patterns in a particular size.  Select all of the pat-
terns.  From the Tools menu, select ‘Memorize Marker’.  Go to a
new table of the patterns in a different size.  Select all the pat-
terns.  From the Tools menu, select Memory Nest.  Your patterns
are nested in the new table in the new sizes just as they were
nested in the original sizes.



Nesting at Table Center
You may find it helpful to nest a specific pattern in the exact center of
your fabric.  Nesting the largest of your patterns in the precise center
and nesting smaller patterns symmetrically around the center pattern
can provide you with overall more effective nesting techniques.

Nesting Inside an Outline
For companies cutting from unique material shapes such as authentic
animal hides, the Nest Inside Perimeter function is beneficial.  This
function allows you to nest your patterns within non-standard out-
lines or perimeters.

To Nest Inside an Outline/Perimeter
1. Mark two points directly on the material or hide to be cut.
2. Digitize your material or hide along with the two points.   (This

can all be done automatically using ‘HideShot’).  These plot
points will be used later in this process to orient the cutter to
the unique shape of your perimeter on the cutting table.  It is
very important that these two points get digitized exactly as
they are located on your material or hide.  Label the plot points
“p1” and “p2”. 

3. Drag, drop, and position your perimeter in the nesting view.  
4. With your perimeter selected, from the Table menu select Nest

Perimeters>Convert to Nest Perimeter.  Your perimeter
changes to yellow.  If you wish to move it you will have to click
right on the perimeter rather than within the bounds of the
perimeter.
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Drag your patterns from the Pattern View into the Nesting View.
Select the pattern you want to nest at the center of your table.
From the Table menu, select Nest Selection at Table Center.  The
pattern is nested at the center of your fabric.



5. Drag and drop your patterns to the nesting view.  In Nestle
Mode, you can easily nest your patterns within the perimeter.  

6. After nesting your patterns within the perimeter, you are ready
to prepare for cutting.

To Cut Inside an Outline/Perimeter
1. Position your hide or other material on your cutting table.
2. From the Table menu, choose Nest Perimeter>Locate Nesting 
3. Move the carriage so the pen points at p1.  Press “Enter Point”

from the Keypad Display Module (KDM) once.
4. Move the carriage so the pen points at p2.  Press “Enter Point”

from the KDM once.
5. Go to your computer and press OK.
6. If you are dealing with hides or other imperfect material, you

may want to locate and digitize your flaws, re-nesting some of
your patterns around them if necessary (see Nesting to Avoid
Material Flaws).

7. When you are ready to cut your patterns, press “Go Home” on
the KDM twice to be sure you are at the global origin (0,0).

8. From the Main Menu go to Plotter Setup>Plot Current Table
(Shortcut: F10).  From the KDM press “ONLINE” and then
“START”.  Your patterns will be quickly and accurately cut!  

Nesting to Avoid Material Flaws
If you are cutting on a fabric or material with flaws, you can use
PatternSmith to nest your patterns in a way that will avoid these
flaws.

To Nest Around Material Flaws
1. Prepare your material on the cutting table.  Now you need to

find any flaws in your material and get out a tape measure.
Begin your measurements from the pen’s starting position for
the plot/cut job you will be doing.  From here, measure to the
location of your material flaw along the X-axis (along the
length of the cutting table).  Then measure up along the Y-axis
until you reach the center of your material flaw.  These are the
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measurements you’ll later enter into PatternSmith in the
Postion X and Position Y spaces.

2. Next, measure from one side to the other of your material flaw,
first in the X direction and then in the Y direction.

3. Now that you have all your measurements, return to the
PatternSmith screen.  In the Project Window, after nesting at
least one of your patterns, go to the Table Menu and select
‘Edit Material Flaws’.  The Material Flaws dialog box appears.  

4. Click ‘Add Flaw’.  The Add Flaw dia-
log box appears.

5. In the Add Flaw dialog box, ‘Position’
refers to the (x,y) coordinates of the
flaw, measured from the starting
point on your table.  Here you’ll enter
the X and Y measurements that you measured from your start-
ing position to the center of your material flaw.  

6. In the ‘Size section of the dialog box, enter the width of your
flaw in the X direction into the Delta X box, and enter the
width in the Y direction into the Delta Y box.

7. If your flaw is at an angle, you can rotate your flaw field as nec-
essary.

8. You can add or remove as many fields as necessary.  Each field
is color coded to make adding and deleting flaws simple.
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Automatic Nesting
PatternSmith includes an option of automatic nesting using
NesterServer, available from Nester Software. After automatic nest-
ing, you still have the ability to move your pattern copies as usual.  

Note: Automatic Nesting will only work if you have Nester
Automatic Nesting Software installed!

Draft Mode
In Draft Mode, Nester will position your patterns quickly, but
with a somewhat reduced efficiency.  You should expect a 2%
to 5% reduction in efficiency in Draft Mode when compared
with Complete Mode.

Complete Mode
In Complete Mode, Nester will
do the best possible job within
the time limits you specify.
You should allow up to two
minutes per pattern for
Nester’s best possible per-
formance and efficiency in
nesting your patterns.
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Set the quotas and rotation constraints for all of the patterns in
the project.  Select all of the patterns you want nested.  From the
Tools menu, select Automatic Nesting.  The Nester Automatic
Nest Task dialog box appears.  Select Draft Mode or Complete
Mode, specify any needed parameters (pattern count/requested
time limit), and click Begin.  PatternSmith sends your patterns to
NesterServer and places the nested copies on the current material
and table.  The settings entered for Distance Between Copies in
the Nest Settings dialog box are used for spacing.



Checking for Overlaps and Out of Bounds 
Before plotting or cutting, PatternSmith can check
for overlaps or out of bounds errors.  

Efficiency
As you are nesting, the bottom status bar continually updates the
length of material in use and the efficiency of material usage.  From
the Table menu, you can simultaneously review these statistics for all
of your tables.  
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Click on empty space to deselect all patterns.  Click the Overlap
button.  Any overlapped copies are now highlighted.  Click on the
Out of Bounds button to highlight any copies that extend past the
material edge.

Locate the material length and efficiency figures in the bottom
status bar.    For length and efficiency statistics for all of the
tables, click Table Efficiency on the Table menu.



Grouping / Ungrouping Copies
The Grouping tool enables you to temporarily keep a group of select-
ed copies together.  Clicking on one copy causes the entire group to
be selected.  The group now moves as a unit.  The Ungroup button
separates the previously grouped copies.

Rotation Toolbar
The Rotation Toolbar enables you to rotate selected patterns or
copies by a specified number of degrees.  It also lets you flip them
about a horizontal or a vertical axis.  
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Zero: Rotates to alignment set in Editor
+45: Rotates copy 45 degrees counterclockwise
-45: Rotates copy 45 degrees clockwise
+90: Rotates copy 90 degrees counterclockwise
-90: Rotates copy 90 degrees clockwise
180: Rotates copy 180 degrees
Incremental Rotate: Rotates copy by specified angle
Flip Horizontal: Flips copy about horizontal axis
Flip Vertical: Flips copy about vertical axis
Align by Element: Aligns copy to make element horizontal

Select the copies you want to group.  Click the Grouping tool.  To
ungroup the copies, click the Ungroup button and then click on
empty space to deselect the copies.  The patterns again function
independent of each other.



Most of the Rotation buttons operate on the currently selected pat-
terns or copies.  The Flip functions are different.  If you flip a pattern,
its copies will automatically flip also.  Flipping a copy, however, does
not affect the parent pattern.

Align by Element tool
This tool automatically positions a copy so a preset element is hori-
zontal.  It is used in conjunction with the Set Align Element button,
found on the Attributes Toolbar in the Editor.  

Copying an Entire Table
Any number of selected copies, or all of the copies on a table, may be
copied and then pasted to a new location.
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Create one or more lines (align elements) in a copy or pattern.
Set them to reference.  Using the Set Align Element button on the
Attributes Toolbar, set them to be align elements.  Click the Align
by Element button to position the copy so the align element is
horizontal (parallel to the material edge).  If a copy has more
than one align element, each click of the Align by Element button
repositions the copy to the next alignment setting.  

Selected Copy 
Select the desired copy or copies and press the Copy button.
Press Paste and a new copy appears in the Nesting View.
Drag it to the desired location.

Entire Table
Select all of the copies on a table and press the Copy button.
From the Table menu, move to another table number.  Click
Paste to insert the copies on the new table.



Flipping an Entire Table
An entire table of copies may be flipped about a horizontal axis.  This
function is especially convenient when you are cutting copies for a
symmetrical object.  When you have nested one side, copy the table
to another table and then flip the new table.

Removing Empty Tables
With up to 100 nested tables in a given project, it’s important that
you be able to manage your nested tables and delete specific tables
when necessary.  

Nesting to Stripes or Plaids
PatternSmith allows you to easily nest copies on striped or plaid
material.  Using alignment elements, horizontal and/or vertical snap-
ping, and nestle mode, you can ensure that the stripes or plaid lines
will be correctly located on your copies. 
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Delete patterns on obsolete tables.  From the Table menu, select
Remove Empty Tables.  The empty tables are removed from your
table sequence.

From the Table menu, move to the table that you want to flip.
Open the Table menu again and then click Flip Entire Table.



To Nest on Plaids
1. In the Material Library, create a material with a plaid pattern.
2. Set the X and Y repeat distances to 10 inches.
3. Copy the material to the project.
4. On the Materials Toolbar in the Project Window, select the new

plaid material.
5. After taking a pattern into the Editor Window, short horizontal

and vertical lines where you want the plaid match-lines to be. 
6. Set both lines to reference and turn on the alignment attribute

for each.  
7. Click Done to return to the Project Window.
8. From the Nest Mode Toolbar, turn on the Snap

Horizontal and Snap Vertical function buttons.
9. Click the Nestle Mode button.  
10. Place a copy of your pattern on the table.  If the

copy is not at 0° rotation, click the 0° button on the Rotation
Toolbar,

11. Move the pattern around on the table.  You will see it snapping
the internal alignment lines to the closest material plaid lines.
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In the Material Library, create a plaid or striped material and
set the repeat distance.  Copy the material to the project.
Select the new material from the Project Window.  In the
Editor Window, add horizontal and vertical alignment lines to
each pattern.  Turn on the Horizontal and Vertical Snap func-
tions from the Nest Mode Toolbar.  Click the Nestle Mode
button.  With each of your patterns at 0° rotation, nest pat-
terns as desired.



Plotting/Cutting
Preparation for plotting and cutting begins

in the Project Window’s Plot Menu.  Here

you provide necessary configuration infor-

mation about your plotter or cutter.

PatternSmith will plot one copy, one table,

or an entire list of materials and tables. 
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Plotter Status Dialog Box



Plotter Setup
Before plotting or cutting, PatternSmith needs to know all about your
plotter or cutter.
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From the Project Window’s Plot menu, select Plotter Setup.  A
dialog box appears.



Configuration
Plotter/Cutter Type
Select your model plotter or cutter from the selection box.
Enter the number of units (steps or encoder pulses) per inch.  

Output
You can choose to send output to a Com (serial) Port or to a
file that will be sent later.  If you select File as your output
device, enter the name and location of the file. You can also
choose to communicate through an Ethernet network if your
network uses a TCP protocol.  Select the radio button for
Ethernet, and then click Find Connection.  If your cutter is
turned on and connected to the network with an Ethernet
cable, the Plotter
Connections dialog
box will appear.  If
the last digits of
your IP address are
not set, you can set
them by clicking Set
IP.  You may need
to obtain your IP
address from your
network adminis-
trator.

Output Scale
You can plot a scaled-down version of the nested patterns.
Enter the desired percentage in the Output Scale box.

Silent Command Log
Check this box to send the plotter commands to a file as well
as to the cutting table. This is used for debugging in conjunc-
tion with output to a COM port.
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Options

General Plotting Options 

Home When Finished
Sends the cutter back to the start point at the end of cutting.

Cut Off Material Left
Cuts off the material at the left after all copies are cut.
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Cut Off Material Right
Cuts off the material at the right after all copies are cut.

Do Out of Bounds and Overlap Check Before Plotting
Checks for overlaps and out-of-bounds errors among your
patterns before plotting.

Plot /Cut Order
The plotting and cutting operations can be executed in any order.
PatternSmith can do all of the plotting on each copy and then cut
that copy, or mix the two operations together.  If you need to plot the
entire table, and then pause before cutting, select the Entire Table
option for Pause and Home after Pen.

Drill Holes before Cutting
Select this if any drill holes are near a cut edge or if your pat-
terns are small.

Allow Element Reversal
Plot optimization will be better if elements can be cut in
either direction.  Leave this unchecked if you want to control
the direction of cut.

Plot Notches InLine
Notch elements can be plotted or cut before the perimeter, or
InLine, as the perimeter is cut.  This works best when you use
PatternSmith style notches.  Notches also cut better if you use
a Notch Tool.

Plot Interior Closed Paths First
If you are nesting pattern pieces inside a larger perimeter, you
may want all interior closed paths plotted or cut first, to pre-
vent fabric shifting.
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Speeds

Maximum Velocity
Enter the maximum velocities you want for curves and for
text.

Maximum Acceleration
The value you enter for maximum acceleration is used to set
the speed on all curves so that the centrifugal acceleration will
not exceed the capability of your plotter or cutter (max value
140).

Use Precision Speeds
Check this box when you need precise placement for very
small and intricate patterns. This will slow the acceleration
rate of the cutting table.
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Table Size

Length and Width
Enter the actual cutting length and width of your system.

Framing
Framing enables you to plot patterns that are bigger than your cut-
ting table, by dividing the table into frames.  

Enable Framing
Check this box to activate the framing function.

Frame Size
Type in the size of the frame. The frame size needs to be a
minimum of twelve inches. Frames can cross copies.

Align Line
This line is the alignment mark between frames.  Enter the
desired length.
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Devices
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Total Devices
Use the Total Devices Selector box to set the number of plotting or
cutting devices on your cutter.  For each device, select the blade type
that is attached to the tool holder.

Offset from Pen
Enter the distance from the pen to the cutting device as accu-
rately as possible.  This is easy to measure if you put masking
tape under the pen and blades and lower and raise each one,
putting a mark on the tape.

Over/Under Cut
A rolling blade will always overcut at corners by an amount
that depends on the thickness of the material.  You can elimi-
nate this by entering an undercut (negative number) in the
Over/Under Cut box.  A tangential blade may require a small
amount of overcut (positive number) in order to cut corners
cleanly.

Tool Assignments
You can set elements to Plot Type Cut1 or Plot Type Cut2 on the
Attribute Toolbar in the Editor window.  Plot Types can then be
assigned to a specific blade or to a specific blade holder (device).

Map Entity Cut Type to Blade
This selection will assign Cut 1 to the Rolling Blade, and Cut 2
to the Tangential Blade. 

Map Entity Cut Type to Device
This selection will set Cut 1 to Device 1, and Cut 2 to Device 2.
You determine which blade will be used on each device. 

Map All Entities to Pen
Select this radio button when you want to plot all plot and cut
elements.
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Enable
You can enable or disable any element plot types.  This sec-
tion also shows which element plot types are assigned to each
device.

Special Blade Options
Use the Tangential Blade for Radii when the radius of your copy is
too small for the rolling blade.  It is important to know that the tan-
gential blade must be on either Device 1 or 2 for this option to be
activated.

Plotting Options
When your patterns are finished and your tables are nested, you are
ready to plot.  From the Plot drop-down menu, you can plot a current
selection, the current table, or several tables.
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Selection At …
Plot Selection At… allows you to determine where the plotter will
begin plotting/cutting selected copies.  (Notice that this option is
only available when copies are selected.)

Local Origin
Plotting of the selected copies begins wherever the cutting
head is currently positioned on the table (the local origin).

Actual Position
Plots the selected copies at their location in the Nesting View.

Plot Current Table
This option enables you to plot the table currently shown in the
Nesting View.  

Multiple Images
This function lets you automatically plot the current table
multiple times.  You will see a new Material Requirements
section as below.  Select the number of multiples of this table
and begin the plot.
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Starting at this copy
A selected copy is the starting point for plotting/cutting.  All
patterns from the selected copy to the end of the table will be
plotted.  The cutting table will not plot or cut any patterns
that are closer to the origin (0,0) than the selected pattern.
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Plot Current Material
Select this option to plot all tables of the current material.

Starting at this table
This function plots and cuts the copies on the table you are
currently viewing, and then progresses to tables of higher
number on the same material.

Starting at this copy
This function will begin plotting from a selected pattern on
your current table, ommitting patterns placed before it on
your material.  It then progresses to tables of higher number
on the same material.

Plot All Materials
Select this option to plot all tables of all materials in the project.  The
program will automatically cycle through them in the order shown in
the Material Selector.  The Plotter Status Dialog Box will prompt the
operator with the name and width of each material and table to be
cut.  If you need to interrupt a cutting job for any reason, you can
resume where you left off by using the following options:

Starting at this material
With this function, your patterns will be plotted and cut start-
ing with the material currently selected.

Starting at this table
This function plots and cuts your patterns starting with the
currently selected table.  It then cycles through each of the
remaining tables on that material, and then progresses
through each of the remaining materials on your Material
List, cutting each table for each material. 
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Starting at this copy
This function begins plotting and cutting from a selected pat-
tern on your current table, ommitting patterns placed before
it on that material.  It then continues through all tables of all
materials in the order shown in the Material Selector.

Pattern Pick-up for Laser Projection
Systems

If you are using a Laser Projection pickup system, this option allows
you to set the pickup order for your patterns.  Select what patterns
need to be picked up first, and your Laser Projection system will
point to your cut patterns on
the cutting table in the order
you selected.  If you are in an
industry working with prepreg
carbon fiber materials or any
other materials where you are
working under a time limit,
our feature allowing you to set
the pickup order will be
invaluable.  

From the Table drop-down
menu, select Set Pattern
Pickup Order.  The Set
Pattern Pickup Order dialog
box appears.
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Here you can arrange your patterns in any desired order for pickup
by dragging them into position and clicking Apply.  You can save
your configuration if desired.

Now, when your patterns are cut, your Laser Projection System will
point to each pattern on the table in the order you established, mak-
ing pattern pick-up easy and fast.
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Plotter Status Dialog Box
The Plotter Status dialog box will appear when you start a plotting
operation.

The Start button will initially be grayed out, until your plotter or cut-
ter is OnLine.  At that point, press either the Start button on the
screen or on the cutter to begin plotting.
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Material Requirements:
This shows you the name and width of the material required
for the current table.  It also shows the actual length and
width that will be used for this table.

Plotter:
Command shows each command as it is sent to the cutter.
Mode shows whether the cutter is online or offline.
Status shows the current status of the connection to the cut-
ter.  Any error messages coming back from the cutter will
appear here.

User origin:
The current location of the cutter is shown here.  The max
location is the max starting location without causing an Out of
Bounds condition.
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Digitizer
The Digitize tool enables you to copy physi-

cal patterns into PatternSmith.  Coordinate

information may be input through any digi-

tizer with an installed Win Tab driver.

Large patterns may be digitized through an

Autometrix cutter.  
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Starting Digitizer
Click the Digitize button on the Project Window’s Plugins Toolbar or
on the Editor Window’s Digitize Toolbar.  If you are not already
there, the Editor Window opens.  All creation tools are  available.
Input coordinate information with the digitizer cursor, and use your
mouse to select tools and menus.  

Digitizing On a Tablet
The Editor Window’s Digitize Toolbar provides the tools needed to
quickly digitize a pattern.  

PatternSmith accepts information from a four-button cursor or a
one-button cursor.  On a four-button cursor, each button performs
the following functions:

Button 0: 
Click once to add a point.  Double-click to end an element.

Button 1: 
While creating an element, click to add a notch.  Notches
must be entered as you are creating the element.  You cannot
go back and add notches after you have finished the polyline. 
Before starting a polyline, click Button 1 to turn on smoothing
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Digitize: Enables the digitizer tablet mouse.
Undo a Point: removes the last point you added.
Zoom to Tablet: Sets the screen to view the whole digitizing tablet.
Digitizer Info: Displays information about your digitizing tablet.  



for a curved polyline.

Button 2:
Click to undo the last point made in the polyline.  This func-
tion can be repeated to undo multiple points

Button 3:
Click to end an element.  (Alternatively, double-click button
0.)

You can switch back and forth between the digitizer and the mouse to
best edit your pattern.  Moving the mouse or cursor determines
which device is active.  Notice that at the beginning of a digitizing
session, the Create Polylines tool is automatically selected on the
Creation Toolbar.  Use the mouse to select other creation or editing
tools.

Snapping
During digitizing, the Snap Function is automatically enabled for
endpoints.  The snap distance is preset to a very small value.  This
prevents accidental snapping when you are working with small ele-
ments.  You can change the snap-to locations and the snap distance
from the Options menu.

Digitizing From the Cutting Table
Digitizing from the cutting table is similar to digitizing through a
tablet.  There is only one button available however (Enter Point) and
it acts as Button 0.  Click once to add a point.  Double-click to end an
element.  Add notches later, using the Notch Creation tool.
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Grader Plugin
Grading is the process of creating larger

and smaller sizes from an initial base size.

Each pattern in a project can be resized

using a Grade Rule from the Grade Rule

Library.
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Starting the Grader
In the Grader, you can create multiple sizes of a pattern and then
resize those patterns later as needed.

For this section, you will need to open Campshirt_Graded.pat, locat-
ed in the following folder:

C:\Program Files\Autometrix\PatternSmith\Tutorials

When you bring your patterns into the Grader, the Grade Library
Options box appears.  You can choose to open an existing library of
grade rules, create a new library, or grade without the use of a
library.
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Select the pattern or patterns you want to grade.  Click the
Grader tool on the Project Window Toolbar.  The patterns are
now in the Grader. 



Now that your patterns are in the Grader, let’s take a look around.

Grade Rule Library Toolbar
In the upper right corner of the Grader
screen, you’ll see the Grade Rule
Library.  The Grade Rule Library (GRL)
holds the information necessary to
change a base size into any other size.
It is organized by File name (ending
with .grl) and Style name.  The Library
Toolbar lets you create a new library,
open an existing library, or save a library.

190 PatternSmith 



Sizes Toolbar
The Sizes Toolbar displays the
sizes in the current Grade Rule
Library.  It enables you to add,
delete, or edit sizes.  The base
size, shown with a selected radio
button, is the original size you
designed.  All other sizes are
derived from it according to the
grade rule library rules. 

Click the Edit Sizes button to see the  Edit Sizes dialog box.
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Add 
Add a new size at the end of
the list.

Insert 
Add a size above the selected
size.

Edit 
Change a selected size name.

Delete 
Delete a selected size.

New 
Create a new Grade Rule Library (.grl) file.

Open
Open an existing Grade Rule Library (.grl) file. 

Save As
Change the name of the Grade Rule Library (.grl) file. 



Grade Rules Toolbar
A Grade Rule determines the
distance and direction that a
pattern point moves when a
pattern changes from one size
to another.  To grade a pattern,
the endpoints of each pattern
element must be assigned a
Grade Rule.  The Grade Rules
Toolbar lets you to copy grade
points from the current Grade
Rule Library to the patterns
shown in the Grader Window,
or from the pattern to the
library.

Copying Grade Rules
The library information is organized by file name, pattern name, and
point name.  In the example below, campshirt.grl is the file, Front
Left is the pattern, and Hem Center is a grade point.
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Hem Center



Copy to Pattern Command
This function copies grade points from the Library to
the selected pattern on the Grader Window.  You can
copy a single point or an entire pattern.

Copy to Library Command
Using the Copy to Library function, you can also copy
grading information from a pattern to the GRL.
Single point grade rules can be copied or the grade
rule for the entire pattern.  Select points and/or pattern names in the
same way as you did for the Copy to Pattern function.  (Remember
that points on a pattern are copied in counter clockwise order.)
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To Copy a Grade Rule to a Single Point 
Select a Grade Rule point in the Grade Rules toolbar, and its
corresponding point on the correct pattern.  (Hold the cursor
over a point to see it’s point name.)  Click Copy to Pattern to
copy the grading information to the selected point.

To Copy a Grade Rule to an Entire Pattern
Select a Pattern Name in the Grade Rule toolbar, and the first
Grade Point on the corresponding pattern. (To determine
which is the first point in the list, see the pattern’s Grade
Point list in the library.)  Click Copy to Pattern to move the
grading information to the selected pattern.  Points will be
copied from the GRL to the pattern in counter clockwise
order, starting at the selected point on the pattern.



Copying from One Grade Point to Another
You can copy and paste grade rules
between points on patterns.  Your
copy options are available on the con-
text menu shown when you right-click
on a grade point.

You can flip the grading vectors in the
X or Y direction at the same time you
paste.  (This is useful when grading
symmetrical patterns.  Develop grade
rules for half the pattern, then Copy
and Paste/Flip to grade the other half.)

Editing Grade Rules
You can edit a point’s grading rules from the Grade Point dialog box.
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To Copy from One Point to Another
Right-click on the grade point you want to copy.  Select Copy
on the context menu.  Right-click on the point you want to
replace, and click one of the Paste functions on the context
menu.

To edit a point’s grading rules in the Grade Point dialog box,
double-click on the point, either on the pattern or in the Grade
Rules Toolbar.  Or, right-click on a pattern point and then select
Properties.
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Pattern
The name of the pattern is set from the Properties Page in the
Project Window or in the Editor.

Point
Enter any name for this grade point here.

dX
These figures designate the distance that point is moved, in the x
direction, for each size change.

dY
These figures designate the distance that point is moved, in the y
direction, for each size change.
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Editing a Grade Point in X-Y Coordinates
Zero X
This tool sets all the dX distances to zero.

Zero Y
This tool sets all the dY distances to zero.

Flip X
This function flips the X values about the base size.

Flip Y
This function flips the Y values about the base size.

Equal X 
This function spaces all of your X coordinates evenly according
to the difference between the highlighted size and the base size.
First, select a size that has the desired dX value.  When you click
the Equal X function, the selected dX value will be divided by the
number of sizes away from the base size, and all dX values will
be set to that.

Equal Y
This function spaces all of your Y coordinates evenly according
to the difference between the highlighted size and the base size.
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Editing a Grade Point in Polar Coordinates
Zero Distance
This tool sets the distance (both dX and dY) to zero.

Zero Angle
This tool sets to angle to zero (horizontal).

Flip Distance
This function flips a point’s distance from zero, mirroring it.

Flip Angle
This function flips the point location by 180 degrees.

Equal Distance 
This function spaces all of your points at equal distances at the
same angle.  

Equal Angle 
This function spaces all of your points at a constant distance at
equal angle increments.



Comparison Table
The Comparison table compares the lengths of selected elements for
each size in your project.
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To Use the Comparison Table
Select all of the elements that you want to include in Selection
1.  (Use the Shift key to select multiple elements.)  Click the
Selection 1 button at the top of the table.  Select all of the ele-
ments that you want to include in Selection 2.  Click the
Selection 2 button.  The Comparison Table displays the
cumulative length of the elements in each selection, for each
size.



Creating All Sizes in the Project Window
From a base pattern size, you can quickly create graded patterns in
the Pattern Window.  They can then be nested on your material.

Select the patterns in the Project Window.  Right-click in one of the
patterns and select Properties.  The Pattern Properties box appears.
Select the Grading tab.  
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To Create Sizes
From the Create Pattern For Size
dropdown, select the desired
size(s) and click Create.  Or, to cre-
ate patterns of every size, click
Create All.  The new patterns are
now in the Pattern Window.
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Slicer Plugin
The Slicer Window lets you slice large pat-

terns into panels that will fit well on your

material.  You have complete flexibility in

the slice line placement.  Seam allowances

and notations can be added automatically.

This tool is very useful for applications in

industries that deal with large objects such

as pool covers, tension structures, or sails.
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Pattern Preparation before Slicing
Before locating slice lines, make sure the pattern is ready for slicing.
Then move it into the Slicer Window.

Make sure there are no copies of the pattern in the Nesting View.
From the Editor Window menu bar, make sure the perimeter is set to
Perimeter by Element instead of Box Perimeter.  (If the perimeter is
set to Box, Slicer cannot add seam allowances automatically.)

To move the pattern from the Project Window  into the Slicer
Window, first select it with the left mouse button.  Click the Slice
Pattern button on the Tools toolbar.  The pattern is now in the Slicer
Window.
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Slice Lines
You can choose the locations where you want to slice your pattern,
called Slice Lines.  Initially, slice lines are spaced according to a
default setting.  Once located, they can be easily moved to different
positions with your mouse.   As you move any slice line, the others
will follow in order to maintain the minimum and maximum spac-
ings you request.

Setup: Locating Slice
Lines
From the Slicer Setup dialog
box, you can set the maxi-
mum and minimum slice size,
and seam allowance data.

Click Setup on the menu bar.
Subtract your seam allowance
widths from your material
width and enter this figure as
Maximum Slice and Default
Slice.  To add seam
allowances to either or both
edges of your panels, enter
the desired size as Left Seam
Width and Right Seam
Width.  PatternSmith will
automatically add a panel
number inside the seam
allowance.  To add a label
also, enter that text into the
Right Label or Left Label
field.
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Moving Slice Lines
Slice lines may be dragged to new locations. While dragging, the
Snap (Ctrl) key may be used to cause the slice line to snap to any
point on the pattern.

Slice line movement is limited only by the minimum and maximum
slice width set in the Slicer Setup dialog box.  If you continue to drag
the slice line after the maximum width is reached, PatternSmith
moves the other slice lines, keeping all slices within the size parame-
ters.  If necessary, it will bring a new slice line onto the pattern.

Slicer Toolbar

Lock / Unlock Slice Lines
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Left-click, hold, and drag a slice line to the desired location.  To
snap the line to a pattern point, press and hold the Snap (Ctrl)
key while you are dragging the line.  To delete a slice line, hold
down the Shift key while dragging.  This allows lines to move off
the pattern.

Lock:  Locks a selected slice line into position.
UnLock:  Unlocks a slice line so that it can be moved.
Reset:  Resets all slice lines to original positions.
Rotate:  Rotates pattern to any angle
Undo: Removes effects of previous operations
Redo: Reverses effects of previous undo operations
Preview: 



The Lock tool holds a slice line in position.  The Unlock tool makes a
line movable.

Reset Lines 

The Reset Lines tool resets the slice lines to the default slice width set
in the Slicer Setup dialog box.

Rotate 
This tool rotates the pattern about its center point.  You specify the
number of degrees of rotation in the Incremental Rotate dialog box.
You can also rotate the pattern freehand with the right mouse button.

Slicing
After positioning all of the slice lines, click Slice on the menu bar.
Your pattern is now divided into individual panels in the Project win-
dow.
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To lock a slice line, left-click on that line.  Click the Lock tool but-
ton.  A small padlock appears above the line.  To unlock a locked
slice line, select it, and click the Unlock button.  The padlock dis-
appears.

Click the Reset Lines tool.  All slice lines return to their original
default spacing.



Revolver Plugin
The Revolver Window helps you create the

gore patterns for a 3d object of revolution

from its side view.  It’s useful for objects like bal-

loons or dome tents.
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Starting The Revolver
From the Project Window, select the pattern you want to revolve.
Click the Revolver button on the Tools Toolbar.  The Revolver
Window appears.

On the screen, you see an image of the 3D object of revolution you
are creating.  The Revolver creates this 3D image based on the pat-
tern you designed in the Editor Window.  
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To view your 3D image optimally, you can press “ctrl +” to zoom in,
and “ctrl -” to zoom out.  Left click and hold anyplace in the view
with your left mouse button to drag the image, or right click and hold
to rotate the image as desired.

From the Revolver Window, you can specify the number of gores
desired.  Enter the desired number and click Refresh.  You can also
choose to see your 3D object of revolution as a wire frame outline by
clicking Wire Frame.  

214 PatternSmith



You can select a color for viewing your
image.  Click Colors and choose whatev-
er color you desire.

When you are finished viewing and
modifying your 3D image as desired,
click OK.  The Revolver Window closes,
and you will see your new gore patterns
displayed in the PatternSmith Project
Window, created from the pattern side-
view you designed in the Editor Window
and turned into gore patterns for your
3D object of revolution in the Revolver.

Criteria for Revolving Patterns
1. Your pattern must have one centerline, or

line of rotational symmetry.  This centerline
must be a line element and must be set to
Plot Type Reference.  The other elements
must be attached at endpoints, and form a
profile, or side view, representing one half
of what you want your finished object of
revolution to look like.  

2. Your pattern must have a Box perimeter.
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Pipes 3D
Plugin
Pipes 3D is a powerful software tool

designed to let you create and view 3D

pipes or pipe covers and their 2D pat-

terns.  Pipes 3D computes the shapes

of complex intersections between

cylinders, cones and arcs and turns

those 3D pipes into 2D patterns.

10
Starting Pipes 3D

Creating a Base Pipe

Creating an Intersecting Pipe

Creating a Segmented Arc

Saving your Pipe Configurations

Opening Saved Configurations

Turning Pipes into 2D Patterns



Starting Pipes 3D
From the PatternSmith Project Screen, click the Pipes 3D button on
the Plugins Toolbar.  The 3D Pipes screen appears.  (Your screen will
be empty until you begin creating pipes.)

This is where you will create your pipes.  You build the pipes one at a
time, starting with the base pipe and adding pipes until you have cre-
ated all the intersections and connections you wish. 
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Creating a Base Pipe
To create your first pipe, click New Pipe.  The Intersect Style dialog
box appears.  Here you'll choose what style of pipe you wish to cre-
ate: Cone, Cylinder, or Arc.  You can also select the color you want
your pipe to appear in the 3D interface.  

Next, create a name for your pipe, and enter its length and radius.
For a cone, you will enter the radius at each end.  
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After you have entered this information, click OK.  A 3D image of
your pipe appears on the screen.  You will see three colored lines rep-
resenting the X-, Y-, and Z-axes.  The X-axis is red, the Y-axis is
green, and the Z-axis is blue.  You will also see a seam line drawn on
your pipe.

You can move your pipe display by left clicking and dragging, and
you can rotate your pipe on the screen by right clicking and dragging.
Press Ctrl + or - to zoom in or out, and F5 to zoom all.  
On the left side of the screen, you will see the name of your pipe.
Click the dropdown (+) by the text to display more details.  
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Creating an Intersecting Pipe
Now that a base pipe has been created, you can begin to create your
intersecting pipes.   To add another pipe, in the column on the left,
first select the existing pipe it will be attached to.  With only one pipe
created so far, it will automatically be selected.  Click New Pipe.  The
Intersect Style dialog box appears. 

Here you can select the style of pipe intersection you want to create -
If your base pipe is a cone, the options will be “Cone to Cylinder”,
“Cone to Cone”, or “Cone to Arc”.  Or, if your base pipe is a cylinder,
the options will be “Cylinder to Cylinder”, etc.  Enter a name for your
intersecting pipe, and its length and radius or radii.  

Length is measured from the centerline of the base pipe.  For inter-
secting cylinders, you will need just one radius.  For intersecting
cones, Radius 1 is at the connection point with the base pipe, and
Radius 2 is the outside end of the pipe.  Select a color for your new
pipe and click OK.  

A new screen appears - the Configure Intersection dialog box (shown
on opposite page).  On the black screen, you will see a 3D image of
your pipes.  Here you can position your intersecting pipe as desired.  
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The buttons across the top right open the various editing fields you
will use to position the new pipe correctly.  

In the column on the left, you will see the information for your base
pipe and intersecting pipe.  (Pipes3D temporarily labels your pipes
["Cone A", "Cylinder B"] separately from the names you have given
them.) 

As you edit your pipe position, you will see the 3D image update.
You can zoom, pan and rotate the image while you are entering  posi-
tioning information, using the left and right mouse buttons.
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With the first button selected, the first data entry
field on the left, “Seam Placement,” is open.  Enter
the number of degrees at which you want your
seam placed. 

Default seam placement is
90°.  The x-axis is at 0°. 

The second button activates the Intersect Height
field.  This lets you choose the height at which
you want your second pipe to intersect your base
pipe.  

Height is
measured
as the dis-
tance from
the origin end on base pipes,
or from the intersection end
on intersecting pipes.  The
default value is the midpoint
of the pipe.
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The third button lets you choose the angle by
which you want your intersecting pipe to be
rotated around the Z-axis (centerline of the base
cone), represented by the blue line in the 3D
image.  

The X-axis (red) is 0°.  The
default rotation about the Z-
axis is 90°.

Click the fourth button at the top of the screen
(you will need to use the arrow buttons on the
right and left sides to navigate to other buttons)
to set the angle between the base pipe and the
intersecting pipe.

Zero degrees is vertical and 90
degrees is perpendicular to the
base pipe (blue axis).
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The fifth button lets you make changes to the
length and radius you already specified for your
intersecting pipe. 

Click the sixth button.  If you also check the box
for “Offset From Centerline of A,” you can shift
your intersecting pipe to be offset from the cen-
terline of the base pipe (dimension d).  

You can
also select
an angle
with the offset.  
This angle will differ from the
“Rotate About Z” function

because now Pipes will rotate the intersecting pipe not about the
Base Pipe’s Z axis, but about the new point of intersection with the
offset.

Clicking the seventh and last button at the top of
the screen lets you change the depth of the inter-
secting pipe.  Here you can move the intersection
farther in or out from the center of the base pipe.
Rotate the pipes so that you are looking down the
length of your base pipe to see the changes in the
depth of the intersecting pipe.  
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When you are finished creating your pipe intersection as desired,
click OK.  (You have already selected the color of the intersecting
pipe in the previous screen, but if you would like to change the color,
you can do so before clicking OK.)

Now that you’ve created the base pipe and an intersecting pipe, you
can go on to create as many more pipe intersections as you need in
the same way.  Before creating more new pipes, make sure that the
correct pipe is selected in the column on the left hand side of the
main Pipes screen.  If you want another pipe to intersect your base
pipe, make sure the Base Pipe is selected.  Or, you can create a pipe
to intersect any secondary pipe.  
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Creating a Segmented Arc
In addition to cylinders and cones, Pipes3d lets you create an arc
composed of a series of cylinder segments.  Select ‘Arc’ name it, and
press ‘OK’ to proceed.  

You will see the Create Segmented Arc dialog.  On this screen you
will enter basic size information about the arc and its cylinder seg-
ments.  You will set its position relative to the other pipes on the next
screen.

Enter the Radius of the arc, and the radius of the cylinders you will
use to create the arc.  Sweep angle is the included angle of the com-
plete arc, shown as theta in the diagram.  If you set the Seam Angle
to zero, the seam will be on the inside of the arc.  The Number of
Segments sets the number of pipe segments Pipes will use to create
the arc.

The End Cylinder Style radio buttons change the display to make it
clear how each works.  Note that if you select the first End Style, you
will see one more cylinder than you asked for, since the first and last
cylinders will each be half length.
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Click ‘OK’ and you will move to the Configure Intersection window.
Here, you can see any pipes already created, along with the new arc.
You can pan and rotate using the mouse buttons as usual while you
are setting the arc’s position.

You can set each of the position parameters in the same way as for
cylinders or cones.

When you finish positioning your arc, click
‘OK’ and you will see that the program has
created multiple cylinders.  You can atttach a
new pipe to any of the new arc segments.



Saving Your 3D Pipe Configurations
After you have created your pipes, select “Save” or “Save As” to save
your configuration for easy access in the future.  Navigate to the fold-
er where you want to save your pipes, and select a name for the file.
Your pipe configuration will be saved as a .p3xml file.

Opening Saved Pipe Configurations
You can access any saved pipe configuration again from the main
Pipes 3D window by clicking “Open” and navigating to the correct
folder and file.   
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Turning Your Pipes Into 2D Patterns
After you have finished creating and editing a configuration of pipes,
you are ready for Pipes to turn your 3D pipes into 2D patterns for
plotting and cutting.   From the 3D Pipes screen, simply click “OK” in
the bottom right corner.  Your 2 dimensional pattern pieces appear in
the Project Window of the PatternSmith screen.  

Each pattern has a name corresponding to the title you gave each
pipe.  Hover your mouse over a pattern to display the pattern name.
Your patterns do not yet have seam allowances, so take each pattern
into the editor to set attributes, remove unwanted elements, and add
seams.  
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CadShot Plugin
CadShot is the fastest way to digitize existing

patterns!  With the click of a key, CadShot con-

verts a digital pictures into accurate

PatternSmith patterns, usually in less than 30

seconds!  The finished patterns include notches,

holes, corners, and smooth curves.  
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Using CadShot
Starting CadShot
Taking a Picture
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Refining the Pattern
Refinement Configurations
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Seam Allowances
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Finishing the Pattern
Confirming Notches
Confirming Corners

TroubleShooting



Getting Started: Installation and Calibration
If you are using an Autometrix camera table, either the light table or
the ambient light version, first install the camera software.  Use the
enclosed Autometrix installation instructions for your specific camera
model.  Although you won’t need to use the installed camera controls
directly, CadShot requires them for operation. If you are using a
Twain compatible desktop scanner with CadShot, first install the
scanner software.  Set your scanner for 100 dpi and 256 gray scale.

Installing CadShot software
1. Insert the CadShot CD.  
2. When the Installation Wizard opens, install CadShot.
3. Open CadShot (Start-Programs-Autometrix-CadShot) and then

close it.  This registers the program so that PatternSmith
knows it has been installed.

CadShot and all related camera or scanner software are now
installed.  They will be accessed through PatternSmith.

Beginning Calibration
Next, CadShot needs to be calibrated to compensate for lens distor-
tion, parallax, and pattern thickness.  The first step is to position the
camera lens directly over the
center of the CadShot table.

First, attach your camera to
the geared head on the cam-
era mount, as shown.  
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Note:   Do not run CadShot from the installation CD.  Make sure
to run it from where it has been installed to your harddrive.



Next, position the calibration blanket over your camera table.  All
edges must align with the table edges.  Place a sticky dot with con-
trasting color at the exact center of the blanket.

Positioning the Camera 
1. Open the viewer on the back of the camera.
2. Level the camera lens using the tripod controls. (Place a bubble

level against the lens cover and adjust the controls until the
camera is level.)

3. Move the camera mount until the centermark in the LCD view-
er is on the center of the calibration blanket.

4. Tighten the camera mount bolts to secure the camera centered
over the calibration blanket.

5. Use the tripod control to rotate the camera to align the picture
with the digitizing table.

6. Double-check the lens level and the center alignment.
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Calibration Blanket



Taking a picture
In order to complete the calibration process, you will need to take
pictures of the calibration blanket with the colored sticky dot current-
ly on your CadShot table.  Open PatternSmith and click the CadShot
button.  CadShot opens, displaying the previous picture taken.  Or, if
this is your first time opening CadShot, the screen will be blank.

Take a picture by clicking
the dropdown button next
to the camera icon on the
toolbar and selecting the
“Take Picture Only”
option. 

Adjusting the tilt of the camera:
The photo you just took is displayed in the CadShot window.  You
will see crosshairs in the photo, showing the center of the camera
field.  Adjust the camera alignment, using the camera-mount adjust-
ment knobs, until the camera is aimed at the center of the calibration
blanket.  Adjusting A will align the X axis.  Knob B aligns the Y axis,
and C adjusts the rotation.  If the calibration circles are not parallel
to the edges of the picture, adjust the camera rotation knob to make
the camera square to the table.
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Final Calibration
With the camera positioned and aimed properly, and the calibration
blanket centered on the CadShot table, you are ready for the final cal-
ibration steps. 
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From the CadShot window, click the Calibrate button.  Fill in the
information appropriate for your table size.  (You will find this infor-
mation in the enclosed installation information specific to your
CadShot system.)

When you click the ‘OK’ button, CadShot will take one more picture,
and attempt to locate all the holes in the calibration blanket.  When it
reports success, remove the calibration blanket.

Place the height gauge at the center of the
table.  From the dropdown arrow next to
the Calibrate button, click Calibrate
Height.  

The Calibrate Height dialog box appears.  

Fill in the target height and diameter, and press the ‘OK’ button to
calibrate for pattern thickness.  Calibration is complete.
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Using CadShot
Creating patterns with CadShot is as simple as placing the patterns
on the CadShot table, taking a picture, and selecting the appropriate
parameter set for refining the resulting polylines.  

Placing Patterns on your Table or Scanner

1.  CadShot Light Table
Lift the clear cover and place your pattern over the center reference
point on the light table.  Replace the cover, making sure the pattern
is not creased or folded. 

2.  CadShot Table
Place your pattern in the center of the table.  Make sure all edges are
flat, using double sided tape under the pattern if necessary.  Use the
table color that offers the maximum contrast with your pattern.  Be
careful to check your lighting and check for objects that could be
casting shadows on your  table.

3.  Scanner
Place your pattern on the scanner and close the cover.  If there is not
enough color contrast between the patterns and the scanner cover,
you can place a sheet of colored paper over the patterns before you
close the cover.

Note:   Whether you are using a Light Table, a Table, or a
Scanner, you can place multiple patterns on the table at the same
time.  When doing this, make sure to leave plenty of clear space
between patterns.
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Starting CadShot from PatternSmith
CadShot runs as a Plugin to PatternSmith.  From the Plugins Toolbar
in the PatternSmith Project Window, click the camera icon.  This
opens the CadShot screen.  In the CadShot Window, you will use the
tools on the CadShot Toolbar to acquire the picture for CadShot to
process, set the search boundary, and set the pattern and background
colors.  Then CadShot can locate the outside perimeter edge and any
interior edges.  Finally, you can digitize any internal marks by hand
on the CadShot screen.

CadShot Toolbar
Use the tools on this toolbar to acquire an image from a table or
scanner, find perimeter edges and interior edges, set a search bound-
ary, and calibrate the camera.  

Taking a Picture
If you are using a CadShot table
and digital camera, click the
dropdown arrow beside the cam-
era icon and select ‘Take Picture
Only,” just as you did when you
were calibrating CadShot.
CadShot will take the picture and
display it in the CadShot win-
dow.
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Take a Picture
Find Perimeter Edges
Find Interior Edges
Set Pattern Search Boundary
Calibrate Camera



If you are using a desktop scanner, select ‘Twain Acquire’ and
CadShot will go directly to your scanner’s software.  Set the DPI at
100, color to 256 Gray Scale, and use the full area of the scanner.

Importing a Picture
You can also import an existing bitmap of filetypes .jpg or .bmp.
From the CadShot menu, click Tools / Image / Import.  

When using a bitmap, you will be asked for the scale factor.  If you
know the number of pixels per inch, enter it.  
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Note:   The first time you use a scanner, you need to tell
PatternSmith where to find your scanner.  From the Project
Window menu, click Tools/ Twain/ Select Source.

Note:   When you click the “Take Picture” icon instead of open-
ing the dropdown menu, CadShot will default to the last opera-
tion you selected, indicated by a check mark on the menu.



If you do not know the number of pixels per inch, you can enter 100
for the current scaling, and import the bitmap at that scale.  Then use
the CadShot line tool to draw a line of known length on the bitmap.
From the menu, select Tools / Calibration / Set Scaling.  Click the
‘Measure’ button to set the scale correctly.

Finding the Pattern Perimeter
Once the picture is taken, it is sent to the CadShot Window.  The
perimeter must then be located and visually verified.  CadShot can
locate edges of solid patterns, or line
boundaries drawn on clear plastic.  To
select your pattern style, click Search/
Pattern Edge Style from the menu bar.
Select solid pattern or line pattern.

Three tools are used to check and confirm the perimeter: Pattern
Search Boundaries, Find Edges, and Sampling pattern and back-
ground colors.
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Setting the Pattern Search Boundary

The boundary on the light table can be adjusted.  Usually you will
want it set to the full table size.  Occasionally, you may want CadShot
to ignore an area of the table.  Adjust the boundary by left clicking on
any of the corners, and dragging the boundary as necessary to fit the
pattern.  Make sure that your search boundary includes the complete
pattern.

Finding the pattern edges
Since you may have placed more than one pattern on the light table
or scanner, you need to tell CadShot where to begin looking for the
pattern edges.  Select the perimeter tool, and left click just outside
the left edge of the pattern.  CadShot will create an orange outline
around the pattern’s perimeter.  (Alternatively, you can drag a mar-
quis around the entire pattern.)

Sampling the Pattern and Background Colors
If the orange perimeter line is displayed but does not match the pat-
tern perimeter, or if the orange line is not displayed at all, from the
Search menu you can sample the pat-
tern (foreground) and table (back-
ground) colors to help CadShot dif-
ferentiate between them.  This will
probably only be necessary if the pat-
tern color is very light, or if there is
stray light in the area of the light table.

1. On the menu, click on Pattern and then choose Sample
Pattern Color.

2. Inside the pattern, left click and drag a medium-sized box.
(The box will disappear as soon as you release the mouse
button.)

3. Click on Search again and choose Sample Table Color.
4. Outside of the pattern, left click and drag another medium-

sized box.  Release, and the box will disappear.
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After sampling the colors, use the Find Edges tool to locate and dis-
play the pattern perimeter.

Locating Internal elements
To locate any internal cutouts, select the Internal Edge Tool, and left
click inside the cutout.  CadShot will place a purple line around the
interior edges.  You can do this for any number of cutouts.
Alternatively, drag a marquis around the cutout.

Creating Internal Elements
In some cases, you may want to add plot lines or points to the origi-
nal CadShot pattern.  The toolbar in the CadShot editor window
includes some basic PatternSmith tools that can be used directly on
the CadShot picture.  Anything added to the pattern at this stage will
be visible on the finished pattern.

As in PatternSmith, right click to create internal elements in
CadShot.  Snap and constrain keys also work like those in
PatternSmith.  Zoom closer to position elements accurately on the
photo.

Refining the Pattern
When the pattern perimeter and internal elements have been found,
and all desired elements have been created, click Done! on the menu
bar.  The CadShot window closes, and the PatternSmith Editor win-
dow opens.
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Create Line: Creates a single straight line
Create Polyline: Creates polylines
Create Point: Creates a point
Create Text: Adds text labels



Polyline Refinement Configurations
In the PatternSmith Editor window, the Refine Polylines property
window is displayed.  The refinement process changes the dense
polyline perimeter returned by the digital camera into smooth lines,
arcs, curves, and Bezier curves, with seam allowances and notches.
First, you must specifiy parameters for corners, notches, and seam
allowances, and set your max deviations for lines, arcs, and curves.
When you are specifying these parameters, you can set any number
of different configurations for the polyline refinement and save these
configurations for later use, or you can use the default configurations.

To create a new configuration, select NewData in the Combo Box,
enter your data, and click save.

Corner Parameter Specifications
If CadShot detects a radius smaller than the Minimum Radius speci-
fied, it creates a corner (breakpoint) at that point.  If two corners
occur with a connecting element shorter than the Shortest Feature
parameter, CadShot makes the two corners into one.
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1. Begin with the Corners tab (already shown on your screen).  
2. Enter the minimum radius that you want CadShot to still rec-

ognize as a radius.  Anything below the minimum will be con-
verted to a corner.

3. Enter the shortest feature that you want CadShot to recognize
as an element.

4. Enter the smallest angle change that you want CadShot to rec-
ognize as a corner.

Notch Parameter Specifications
In order for CadShot to accurately locate all notches in your pattern,
the measurement specifications you enter must be very close to the
actual notch measurements on the original pattern.  If the notches
aren’t well defined, or are varied in the physical pattern, measure the
widest and most shallow ones to specify notch configurations.
Notches must be vee style.

1. Click on the Notches tab.
2. Check the Has Notches box if your pattern has notches.

Uncheck the box if your pattern does not have notches.
3. If your pattern has notches, specify the width, depth, and type

of notches that are on the original pattern.
4. Specify the type, width, and depth of notches that you would
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like on the finished pattern.
5. Check the Confirm Notch Locations box if you’d like

PatternSmith to let you confirmation each notch locations.

Fit Tolerance Specifications
The digital picture CadShot sends to PatternSmith consists of very
dense polycurves.  Specifying the Fit Tolerance parameters allows
PatternSmith to replace these polycurves with lines, arcs, Bezier
curves, and polylines that are thinned and easier to work with.  This
automatic thinning should not be too aggressive, or the pattern shape
may be compromised.  Auto-thin moderately, then finish the job
manually in the PatternSmith Editor window.  Begin with a polycurve
deviation of .03 inches.

1. Select the Fit Tolerances tab.
2. Check Replace with Lines if you want PatternSmith to replace

polylines with lines, within a specified range of deviation. 
3. Check Replace with Arcs if you want PatternSmith to replace

polylines with arcs, within a specified range of deviation.
4. Check Replace with Beziers if you want PatternSmith to replace

polylines with Bezier curves, within a range of deviation.  
5. Specify acceptable ranges of deviation for all checked boxes.
6. Specify how much to thin points on the polyline.
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Seam Allowances Specification
The seam allowance on the final CAD pattern can be different from
the existing seam on the sample.  Enter the seam allowance on the
sample, and the seam you want on the final pattern.  If the sample
has no seams, you can still add a desired seam allowance to the pat-
tern.

If some edges don’t have a seam allowance, check that box. The pro-
gram will give you an opportunity to specify which edges don’t get
seam allowances.

1. Select the Seams tab.
2. Uncheck the box if the pattern does not have seam allowances.
3. If the pattern has seam allowances, specify the size in the

Current Seam Allowance box.
4. Specify the size of the desired seam allowance in the New Seam

Allowance box

Scale Factor Specification
The Scaling function is useful when you are scanning small scale pat-
terns that need to be rescaled before adding a seam allowance.
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Saving Configurations
1. Click the Save As button if you wish to save the configurations

for future use to use on future patterns.  A small window will
appear and ask for the name of the new configuration settings.

2. Enter a name for the settings and click OK.
3. Click OK at the bottom of the window to apply your specifica-

tions.

Finishing the Pattern
Select the Configuration you want to use, and click OK.

Confirming Notch Locations
If you chose to confirm notch locations, you will see a Confirm Notch
Locations screen.  
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This screen shows the perimeter of the pattern in red, highlighting
notches with yellow circles.  A close-up view of a selected notch is
shown in the upper left corner.  You can add or delete notches.

To delete notches:
1. Left-click within the yellow circle surrounding the unwanted

notch.
2. Press the Delete key.  

To add notches:
1. Right-click on the pattern perimeter where a notch is desired.
2. Move the newly created notch (shown in purple) into its exact

position by left clicking and dragging within the close-up view
box.  Use the Ctrl key to snap a notch to a point.

3. Click OK to confirm notch placement.

Confirming Corner Locations
PatternSmith will ask for corner confirmation.  
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Delete, change, and confirm corners in the same way as notch loca-
tions.  In the detail window, you can use the snap key to snap to a
specific point.

When you have finished confirming notches and corners, click OK.
The pattern is now shown in the PatternSmith Editor window,
improved and simplified.  Straight polylines are now lines, and all
curved polylines have been thinned or changed to arcs or bezier
curves according to the specified configuration.  

At this point, you may choose to refine further in the Editor window,
with the original polyline visible as a gray line in background.  For
example, you can slide notches with the notch tool, and add or delete
points using the add/delete tool. When your pattern is finished, click
‘Done’ to exit the Editor window and return to the Project screen.
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Troubleshooting common problems

CadShot times out while attempting to retrieve a picture. 
Make sure the camera and light table are turned on. Make sure no
outside light is hitting the light table.  Excess light makes the pattern
indistinguishable from the light table.

CadShot times out while attempting to find a perimeter. 
Make sure no outside light is hitting the light table. Boundary lines
may be too large.  Change boundary lines, making them smaller and
closer to the pattern edges.  All boundary lines should be blue, not
yellow.  

CadShot returns a perimeter line, but it doesn’t match the
pattern perimeter.
Make sure no excess light is hitting the light table.

Boundary area may be too large.  Change boundary lines, making
them smaller and closer to the pattern edges.  All boundary lines
should be blue, not yellow.

Boundary lines may be too small.  Enlarge the boundary area, mak-
ing sure it is outside the pattern edges.  All boundary lines should be
blue, not yellow. Sample pattern color and table color, then find
perimeter again. 

The boundary lines cross the pattern and return a faulty
perimeter. 
Boundary area is too small.  Change boundary lines, making them
larger and farther away from the pattern edges.

CadShot’s boundary doesn’t include the entire light table
area. 
Check the camera settings.  Set the zoom at 28mm.
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CadShot finds extra corners. 
Manually delete the extra corners within the refining phase.  If the
problem occurs consistently, change the corner configuration settings
to higher numbers.

CadShot misses some corners.
Manually add the necessary corners within the refining phase.  If the
problem occurs consistently, change the corner configuration settings
to lower numbers.

CadShot finds extra notches.
Manually delete the extra notches in the refining phase.  If the prob-
lem occurs consistently, modify your notch configuration settings.
Measure the physical notches and be sure that your notch configura-
tions are set as precisely as possible.

CadShot misses some notches.
Manually add the extra notches within the refining phase.  If the
problem occurs consistently, change the notch configuration settings
to lower numbers.  Be sure that your notch configurations are as
exact as possible.

PatternSmith returns a cut line that doesn’t match the orig-
inal pattern. 
Use the seam allowance tool to adjust to a different type of seam
allowance.  If that doesn’t work, the pattern is too small and should-
n’t have seam allowances. 

PatternSmith returns lengths of elements that do not
match the physical pattern.
When seam allowances are used, Patternsmith’s automatic measure-
ments are of sew lines, not cut lines.  To compare cut line measure-
ments, use the manual measurement tool to measure the cut line.
Compare this measurement to the physical pattern.
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TailorMade
Plugin
Using a few basic dimensions, Tailormade cus-

tomizes a set of patterns for any style.

TailorMade can handle complex, non-linear scal-

ing operations, ensuring that each pattern in a

set will have the correct dimensions and still fit

with all the other patterns.  For each pattern,

dimensions can be related to measured values

and to other dimensions using algebraic formu-

las.
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Introduction
TailorMade makes it easy to create a family of patterns – a group of
patterns that are the same style, but with varying dimensions.  Enter
a few dimensions and TailorMade produces customized patterns,
ensuring that all of the patterns in a project fit together accurately.

TailorMade is perfect for companies that use patterns based on geo-
metric shapes.  Spa cover manufacturers can generate the patterns
needed for a spa cover by entering the length, width, and corner style
and radius.  Awning producers can create the patterns for a given
style with just the height, projection, width, and valance.
Manufacturers of pipe and valve covers, athletic equipment, and dock
seals all use TailorMade.  If you’re a PatternSmith user who doesn’t
yet use TailorMade, we’lll be glad to help you determine if
TailorMade can simplify your company’s patternmaking.  If you’re a
company who’s already purchased TailorMade, this chapter will help
you become familiar with the software. 

Getting Started
There are two ways you can use TailorMade.  We can help you get
started by creating your first templates for TailorMade.  This is fast,
simple, and ensures that your patterns will be ready in a very short
time period.  We call this TailorMade 101 .  Read the TailorMade 101
section for step-by-step instructions.

The second way of using TailorMade is what we call TailorMade 201.
This is for those who are ready for more advanced use of the soft-
ware.  In the TailorMade 201 process, you will learn how to dimen-
sion your patterns, create your own formulas, and create your own
templates.
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TailorMade 101: Let Autometrix Help
1. Using PatternSmith, create all of the patterns for a proj-

ect.  Finish all editing and send Autometrix your ready-to-
cut patterns, complete with seam allowances and notches.

2. Send us a thorough description of the changes in dimen-
sions that occur in the different pieces of a pattern family.
Autometrix will send you back a TailorMade template file
ready for use in TailorMade.

3. Start TailorMade and open your template file.
4. You will see your patterns, with labeled dimensions, and a

Variables window.  If the Variables window is not open,
click View / Variables to open it.

5. The Variables window includes all of the data and equa-

tions for your pattern template.  The top section (gray
background) contains the data that you will be changing
to create a new set of patterns.  In the Expression column,
double click the data you want to change, and enter a new
value.

6. When you have entered all of your new data, click the
Preview button to see your new pattern.  The old pattern
is still visible, shown in gray.

7. To create a PatternSmith file with your new patterns, click
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File -> Export.
8. Open your new patterns in PatternSmith.  They are ready

to nest and cut! 

TailorMade 201: Create Your Own Templates
Learning to use TailorMade will require dedication and maybe even
courage, but we know that the results will make it all worth it.  We
recommend that you work systematically through the documentation
and call us with your questions.  Companies that have invested the
time to learn to use the software have benefited tremendously.  (And
when you’ve completed your first successful template, call us!  We’ll
send you our congratulations along with an Autometrix t-shirt!)

Preparing Patterns
Create all of the patterns for a project in PatternSmith.  Finish all
editing, so that your patterns are in final, ready-to-cut form.  Double-
check the following three details.

Polylines:
TailorMade allows you to set the distance or dimension between any
two breakpoints on a pattern.  While in PatternSmith, make sure that
you break polylines at the endpoints of sections you will dimension.

Seam Allowances:
Make sure that you have seam allowances on your patterns.  Seam
allowances can be changed but not added in TailorMade.

Notches:
Notches should be present on the imported patterns, although they
can be altered or added in TailorMade.  Final notch locations on your
modified patterns can be determined in two ways.  By default,
TailorMade will hold them at their specific distance from the start
point, endpoint, or midpoint.  If you want the notch positions to scale
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with the pattern, you have that option in TailorMade.

TailorMade Overview
After you import a group of patterns into TailorMade, there are three
steps to creating the completed template: 

1. Create dimensions
2. Assign variable names to dimensions that change within a

project
3. Create an expression (formula) for each variable

Let’s look at a basic TailorMade example and see how these steps are
applied.  In this example, we are creating a template for a family of
wedge cover patterns.  You can open the sample file, TestWedge.tpl
to follow along.

1.  Create Dimensions
First, create a dimension between
two points on the pattern.
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2.  Assign Names to Dimensions
Next, give the dimension a variable name.  Here, we have named it
‘C’.  You can type a new name into the Variable Name dropdown, or
select any existing name from the dropdown.

3.  Create Expressions
Last, create an expression for the variable, ‘C’.  Variable ‘C’ is the
hypotenuse of a triangle with legs ‘A’ and ‘B’, so you can use the
Pythagorean theorem to set its length from the lengths of ‘A’ and ‘B’.

After adding the other required dimensions and variables, the tem-
plate is complete.  You can enter new measurements for Height and
Width, and let TailorMade create the exact patterns necessary to
make your desired wedge.  

Chapter 12 | TailorMade 263



You can experiment by changing the values of A and B in the
Variables Window and clicking the Preview tool button.

File Toolbar:

To begin a new project, click New.  

Next, click ‘File / Import’ to import the .pat file you want to dimen-
sion.  The patterns will follow your mouse until you click to place
them on your screen.  Import additional patterns, if needed.    
You can move patterns by selecting and dragging.  Delete a pattern
by selecting it and pressing the Delete key.  
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New: Start a new project
Open: Open an existing project
Save: Save the current project
Import: Import patterns from a PatternSmith.pat file



Clicking ‘Save’ will save your patterns and dimensions in a
TailorMade template (.tpl) file.  To create your modified patterns in a
PatternSmith file, click the File menu, and then Export.

Dimension Toolbar:

With your patterns in TailorMade, you are ready to add dimensions
between any endpoints of elements.

To create a dimension, select the appropriate dimension tool from
the Tool toolbar.  (Each tool is explained below.)  Right click on the
two endpoints you want to dimension.  The program will automati-
cally snap to the closest point.  Drag the dimension line away from
the pattern, and right click again to set its position.  Angle dimen-
sions are created with one click on the corner point.
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Vertical Set vertical dimension between points
Horizontal Set horizontal dimension between points
Diagonal Set dimension between points at any angle
Length Set the length of a line, polyline, or curve
Radius Set the radius of an arc
Angle Set the angle at a vertex between elements
Constrain Hold horizontal or vertical
Dart Set the length of a dart
Pin Fix a point in place
Fillet Set the radius of a corner fillet

Note: Dimensions have a direction, shown by an arrow.  The
first point you click is the anchor end, and the second point is the
moving end.  



You can have a maximum of two arrows pointing toward any point.
Three arrows will usually result in an error message, indicating that
the point has too many constraints on it.  Anchor points are different.
An unlimited number of dimensions can originate from the same
anchor point.
If you need to reverse the direction of a dimension, double click on
the dimension.  The Dimension Properties dialog box will open.
Click on ‘Reverse Direction’ and then ‘OK’.  The direction arrow will
change. 

Vertical or Horizontal Dimensions:
A horizontal or vertical dimension can be assigned between any two
endpoints.  These endpoints may be on the same or on two different
elements.  Setting a horizontal (or vertical) dimension will not force
the two points to be aligned horizontally (or vertically).  Instead, it
establishes the final horizontal (or vertical) distance between the two
points.  If the points happen to be aligned horizontally (or vertically),
and no other dimensions cause that to change, they will remain hori-
zontal (or vertical).

Diagonal Dimensions:
A diagonal dimension between two points will hold the distance
between the points, while allowing related angles to vary.  This
dimension acts like a PatternSmith circle guide to determine possible
end locations for the moving end point.

Element Length Dimensions:
A length dimension lets you set a specific length for an element,
rather than for the horizontal or vertical distance between the end-
points.  It can be applied to one element at a time, never to multiple
elements.  The length is set by an expression equation.  If constraints
from other dimensions require an adjustment, the length of this ele-
ment will remain constant and the related angle will vary.
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Angle Dimensions:
The angle dimension allows you to hold the angle between two ele-
ments constant. Experiment with the wedge examples to see how
powerful this feature can be.  Open ‘Wedge’ in TailorMade.  In the
Variables dialog box, double click on the expression for variable ‘b’.
Enter ‘6’ as the new value.  On the View toolbar, click ‘Preview
Changes’.  Notice that the angle dimensions remained constant.  The
pattern still forms an accurate wedge, but a wedge with a longer base.
Note: TailorMade treats adjacent elements with angle constraints as
a polylines.  This means that you must make all dimensions on those
elements go in the same direction (clockwise or counterclockwise).  

Horizontal / Vertical Locking:
This tool maintains a horizontal or vertical alignment between two
points.  The points must initially be aligned.  If they are not,
TailorMade will not allow you to place a dimension.

Pin in Place:
Any point that is not allowed to move can be pinned in place.  This is
seldom necessary, but can clarify the project for users.
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More About Using Dimensions:
TailorMade operates on a few basic assumptions.  Understanding
these assumptions will simplify the process, and may reduce the
number of specifications you need to make.

1. TailorMade only changes the endpoint at the moving
(arrow) end of a dimension, not the endpoint at the
anchor end.  Although we allow bi-directional dimensions,
they can be confusing and lead to unexpected results.  We
recommend that you only use them when absolutely nec-
essary.

2. In the absence of any other information, TailorMade
moves a point in the direction of the dimension (horizon-
tally, vertically, or in its current direction for a length
dimension).

3. TailorMade initially finds one or more points that don’t
need to move.  It proceeds around the pattern in a counter
clockwise direction, making adjustments based on your
dimensions.    When an endpoint moves, it usually affects
only its immediate neighbor, by moving that neighbor’s
startpoint.

4. Using TailorMade is much simpler if you take a few min-
utes to consider exactly how you want a pattern to change,
and determine which points don’t actually need to move.
Open example files CutPatA.tpl and CutPatB.tpl to see the
importance of this.  Both patterns achieve the correct end
result, but CutPatA uses more logical dimensions and
therefore needs only half as many.
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In CutPatB, the patternmaker started with one fixed point and
dimensioned all of the elements of the pattern.  CutPatA, however,
makes use of the understanding that as the pattern changes, the four
middle points never need to move, relative to each other.  By leaving
them in position, and moving each of the remaining points relative to
one of those fixed points, the dimensioning process was simplified. 
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CutPatB CutPatA

Important!  We recommend that you add only one or two
dimensions at a time, and then preview your work by clicking the
Preview button, which shows your modified pattern.  This allows
allow you to preview  small changes in your pattern to help pre-
vent conflicting dimensions.  



Variables
You will assign variable names and expressions to most of your
dimensions, allowing TailorMade to adjust those dimensions for dif-
ferent patterns.   The Variables Window lists all dimension variables
and their current values.  (If you don’t see the Variables window in
your TailorMade workspace, click View / Variables Window.)  
After you create a dimension, assign it a variable name.  Double click

on the dimension.  The Dimension Properties dialog box appears.  In
the Variable Name drop-down box, replace the dimension measure-
ment with a variable name.  Click ‘OK’. 
Alternatively, you can create the name before you use it by clicking
‘New’ in the Variables Window, and then it will be available to select
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from the drop-down list.  

If you want a dimension to stay constant, create the dimension but
don’t give it a variable name.

If multiple dimensions should be equal, use the same variable name.
A variable name can be assigned to corresponding elements of two or
more patterns.  Note that variable names cannot contain spaces. 

Expressions
The value of a variable often depends on the value of one or more
other variables.  TailorMade lets you establish formulas (algebraic
expressions) that compute updated values based on new data.

To enter a formula for a variable, double click in its Expression col-
umn.  Expressions can be simple or complex, and  can incorporate

any variables you
define.  

The Variable window is
divided into gray and
white background
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areas.  The gray area can be used to simplify data entry.  Any variable
that is not used on a dimension will appear in the gray area.  This
ensures that your data is always at the top of the Variables window,
making it easy to enter changes. 

Create data variables here that are used in expressions for variables
in the white area.  In TailorMade, open ‘Test Wedge’ to see how this
works.  In the gray area, data for Height and Width is entered in the
expression column.  The pattern dimensions, however, show Height
and Width as ‘A’ and ‘B’.   In the Variable window (white area), you
can see that A = Height and B = Width.  Change your data for Height
and Width, and your dimensions change.  

Expression Operators:

The usual algebraic conventions apply.  If you enter an expression
that doesn’t follow algebraic rules, or one that references a variable
you haven’t yet created, it will be shown in red until you correct it.

272 PatternSmith

Math Operations
exprA + exprB Addition
exprA - exprB Subtraction
- expr Negation
exprA * exprB Multiplication
exprA / exprB Division
exprA ^ exprB xponentiation
( expr ) Parenthesis
funcname ( expr ) function call 
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Comparisons
exprA = exprB Equality
exprA != exprB Not equal to
exprA > exprB Greater than
exprA < exprB Less than
exprA >= exprB Greater than or equal to
exprA <= exprB Less than or equal to

Booleans
bool ? exprA : exprB Tertiary Operator
! bool Boolean Not
boolA & boolB Boolean And
boolA | boolB Boolean Or

Math Functions and Constants
e 2.71828182845905
pi 3.14159265358979
sqrt Square Root
sqr Square
sin Sine
cos Cosine
tan Tangent
atan Arctan 
sec Secent
csc Cosecent
ln Natural Log (base e)
log Log (base 10)
abs Absolute Value



Element Properties
While you can’t edit patterns in
TailorMade, you can change some
element properties.

Attributes and Seams
Using the Selector, double click on
any pattern element, to see the
Properties Dialog.  You can
change the element to Plot, Cut, or
Reference, or change the value of
the Seam Allowance.  

Notches
Using the Notch Tool, double click on any element, and you will see
the PatternSmith Notch Properties Dialog, where you can add, delete,
move, or change properties on any notches.
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View Toolbar
The tools on the View Toolbar let you show or hide seams, original
pattern layers, dimensions, labels, values, and errors.  

Use the Preview Modified Pattern button to test your work at regular
intervals to watch for conflicting dimensions.

If you have conflicting dimensions on a pattern, TailorMade will dis-
play the following error message window, showing you which pattern
has a problem and helping you determine what to change.
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Show/ Hide Seams
Show/ Hide Originals Layer
Preview Modified Patterns
Show/ Hide All Dimensions
Show/ Hide Labels
Show/ Hide Values
Show/ Hide Errors Window



Display Toolbar
The Display tools on the Tools toolbar let you select and move pat-
terns and see them at a convenient size and view.

These tools work in the same way as they function in PatternSmith.
You can also use the center rolling wheel on your mouse to zoom the
pattern display in or out.

Exporting PatternSmith Patterns:
To create your modified patterns in a PatternSmith file, click the File
menu, and then Export. Before you create new patterns, you can set
the Name, Quota (number of copies required) and Notch treatment
in the Pattern Properties.  To see the Properties dialog, right click
inside a pattern and select ‘Pattern Properties’.

You can make more than one
copy of any pattern by adding a
variable that holds the quota
number.  Enter that variable in
the ‘Select Quota’ drop-down.  

If you want your notch posi-
tions to scale according to the
length of their element, select
‘Move Notches Proportionally’
and click ‘OK’.
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Selector: Selects and moves patterns
Zoom All: Brings all patterns into view
Zoom: Zoom in with left mouse button, out with right mouse button
Pan: Bring any part of a pattern into view



Copying Variables and Expressions to another project:
At times, you will want to apply all of the variables from one project
to another project.  From the View menu, click “Database Window”.
This window allows you to transfer all variables and expressions from
one TailorMade file to another. 

Examples:
We’ve included the following TailorMade files as examples.

Sample1.tpl
A typical awning

RectangleWrcBase.tpl
A typical spa cover with radius corners

OctagonBase.tpl
An octagon spa cover

CutpatA.tpl
A portion of a cover

Wedge.tpl
A wedge covering
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